Start-up Guide
This guide supports the following models:
MC332dn, MC342dn, MC342dw, MC352dn,
MC362dn, MC362w, MC562dn, MC562w,
MC562dw, ES3452 MFP, ES5462 MFP,
ES5462dw MFP, MPS2731mc

PREFACE
Every effort has been made to ensure that the information in this document is complete, accurate,
and up-to-date. The manufacturer assumes no responsibility for the result of errors beyond its
control. The manufacturer also cannot guarantee that changes in software and equipment made by
other manufacturers and referred to in this manual will not affect the applicability of the information
in it. Mention of software products manufactured by other companies does not necessarily constitute
endorsement by the manufacturer.
While all reasonable efforts have been made to make this document as accurate and helpful as
possible, we make no warranty of any kind, expressed or implied, as to the accuracy or completeness
of the information contained herein.
All rights reserved by Oki Data Corporation. No part of this document may be reproduced in any form
or by any means without prior written permission from Oki Data Corporation.
© 2012 Oki Data Corporation
OKI is a registered trademark of Oki Electric Industry Co., Ltd.
ENERGY STAR is a trademark of the United States Environmental Protection Agency.
Microsoft, Windows, Windows Server, Windows Vista and Internet Explorer are registered trademarks of
Microsoft Corporation.
Apple, Macintosh, Mac and Mac OS are the registered trademarks of Apple Inc.
Other product names and brand names are registered trademarks or trademarks of their proprietors.
AirPrintTM
AirPrint logoTM
iPad®
iPhone®
iPod®
iPod touch®
iPad, iPhone, iPod, and iPod touch are trademarks of Apple Inc., registered in the
U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.
This product complies with the requirements of the Council Directives 2014/30/EU (EMC), 2014/35/EU
(LVD), 2014/53/EU (RED), 2009/125/EC (ErP) and 2011/65/EU(RoHS), as amended where applicable,
on the approximation of the laws of the member states relating to Electromagnetic Compatibility, Low
Voltage, Radio & Telecommunications Terminal Equipment, Energy related Products and Restriction on
the use of certain Hazardous Substances in electrical and electronic equipment.

The following cables were used to evaluate this product for EMC directive
2014/30/EU compliance, and configurations other than this may affect that compliance.
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SHIELD

ENERGY STAR
Target countries of the ENERGY STAR program are the United States, Canada and Japan.
It is not applicable to other countries.
This product is compliant with ENERGY STAR v2.0 only.

EMERGENCY FIRST AID
Exercise care in the handling and use of toner powder:
If swallowed, give small amounts of cold water and seek medical attention. DO NOT attempt
to induce vomiting.
If inhaled, move the person to an open area for fresh air. Seek medical attention.
If it comes into contact with the eyes, flush with large amounts of water for at least 15 minutes keeping eyelids open. Seek medical attention.
Spills on clothing or exposed skin should be washed with cold water and soap to help reduce
risk of staining.
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●●
For Your Safety
Read the Start-up Guide (this guide) and User’s Guide for your safety before using the product.

Cautions related to safety
WARNING

Indicates the presence of a hazard for which not following the instructions noted may result
in serious injury or death.

CAUTION

Indicates the presence of a hazard for which not following the instructions noted may result
in injury.

General cautions
WARNING
Do not touch the safety
switch inside the machine.
Doing so may cause electric
shock due to high voltage.
In addition, gears can rotate,
which may result in personal
injury.

Do not use inflammable
sprays near the machine.
Doing so may result in
fire due to heat within the
machine.

Remove the power plug from
the socket and contact a
customer’s service center if
a liquid such as water comes
into contact with the internal
parts of the machine. Failure
to do so may cause fire.
Remove the power cord
and contact a customer’s
service center if the machine
is dropped or the cover is
damaged.
Failure to do so may cause
electric shock and/or fire
leading to injury.

Remove the power plug
from the socket and remove
foreign material such as
clips if they fall inside the
machine. Failure to do so
may cause electric shock
and/or fire leading to injury.
Remove the power cord
periodically to clean the
plug blades and root section
between the blades.
If the power plug remains
inserted for a long period of
time, the root section will
become dusty resulting in a
short which may cause fire.
Do not place containers with
liquids such as water on the
machine.Doing so may cause
electric shock and/or fire
resulting in injury.
Do not use power cords,
cables, or ground wires other
than those that are indicated
in the User’s Manual.
Doing so may cause fire.

Do not insert materials into a
vent holes.
Doing so may cause electric
shock and/or fire resulting in
injury.
Do not throw toner or image
drum cartridges into fire.
Doing so may cause dust
explosion leading to burns.

If the machine casing gets
extremely hot or if smoke,
unusual odour or abnormal
noises are emitted from the
machine, there is a risk of
fire. Switch off and unplug
the mains connector and
contact your dealer.
Do not operate and do not
disassemble the machine
other than as directed in the
User’s Manual.
Doing so may cause electric
shock and/or fire leading to
injury.
Do not clean spilled toner
with a vacuum cleaner.
Doing so may result in fire
due to the sparks from
electric contact.
Toner spilled on the floor
should be wiped off with a
wet cloth.
Do not touch the fuser and
other parts when opening the
cover of the machine.
Doing so may cause burns.
The operation of UPS
(uninterruptible power
source) or inverters is not
guaranteed. Do not use
uninterruptible power source
or inverters.
Doing so may cause fire.

CAUTION
Do not come closer to the paper’s exit area when
the power is turned on, while printing.
Doing so may result in personal injury.
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Do not touch the liquid-crystal display if
damaged. If liquid (liquid crystal) leaked from
the liquid-crystal display comes into contact with
the eyes or mouth, flush with a large amount of
water. Seek medical attention if necessary.
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●●
About This Guide
Terms in this document
The following terms are used in this guide:
Note

●● Indicates important information on operations. Please ensure you read these.
Memo

●● Indicates additional information on operations. It is recommended that this be read.
Reference

●● Indicates where to look when you require more detailed or related information.

WARNING
●● Indicates the presence of a hazard for which not following the instructions noted may result in serious injury or death.

CAUTION
●● Indicates the presence of a hazard for which not following the instructions noted may result in injury.

Symbols in this document
The following symbols are used in this guide:
Symbols
[]

"

<
>

"

> key

Description
●● Indicates menu names on the display screen.
●● Indicates menu, window, dialog box names on the computer.
●● Indicates part names of the machine or supplied parts.
●● Indicates messages and text entered on the display screen.
●● Indicates file names on the computer.
●● Indicates reference titles.
Indicates a hardware key on the operator panel or a key on the keyboard of the computer.
●● Indicates how to get to the menu you want on the menu of the machine or the computer.
●● Indicates how to get to the section where the related information is described.
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Notation used in this guide
The following notations may be used in this manual.
●● PostScript3 Emulation → PSE, POSTSCRIPT3 Emulation, POSTSCRIPT3 EMULATION
●● Microsoft® Windows® 8 64-bit Edition operating system → Windows 8 (64bit version) *
●● Microsoft® Windows Server® 2012 64-bit Edition operating system → Windows Server 2012 (64bit
version) *
●● Microsoft® Windows® 7 64-bit Edition operating system → Windows 7 (64bit version) *
●● Microsoft® Windows Vista® 64-bit Edition operating system → Windows Vista (64bit version) *
●● Microsoft® Windows Server® 2008 R2 64-bit Edition operating system → Windows Server 2008 *
●● Microsoft® Windows Server® 2008 64-bit Edition operating system → Windows Server 2008 (64bit
version) *
●● Microsoft® Windows® XP x64 Edition operating system → Windows XP (x64 version) *
●● Microsoft® Windows Server® 2003 x64 Edition operating system → Windows Server 2003 (x64
version) *
●● Microsoft® Windows® 8 operating system → Windows 8 *
●● Microsoft® Windows® 7 operating system → Windows 7 *
●● Microsoft® Windows Vista® operating system → Windows Vista *
●● Microsoft® Windows Server® 2008 operating system → Windows Server 2008 *
●● Microsoft® Windows® XP operating system → Windows XP *
●● Microsoft® Windows Server® 2003 operating system → Windows Server 2003 *
●● Generic name for Windows 8, Windows Server 2012, Windows 7, Windows Vista, Windows Server
2008, Windows XP, and Windows Server 2003 → Windows
●● Web Services on Devices → WSD
* I f there is no special description, 64bit version is included in Windows 8, Windows Server 2012,
Windows 7, Windows Vista, Windows Server 2008, Windows XP, and Windows Server 2003. (64bit
version and Windows Server 2008 R2 is included in Windows Server 2008.)
If there is no special description, Windows 7 is used as Windows, Mac OS X 10.7 is used as Mac OS X,
and MC562dn is used as the machine for examples in this document.
The descriptions in this document may be different depending on your OS or model.
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1

1 Machine Setup

Machine Setup

This chapter explains the initial setup for the machine, including the names of the machine
components, how to unpack and install the machine, how to turn on/off the machine, and how to load
paper into tray 1.

●●
Names of Components
This section shows the names of the components of the machine and operator panel.

Machine
The following shows the names of the machine
components.

13

7

8
9
10

6
5

11

No.
Name
13
Document glass

12
4

No.
1
2
3
4
5
6
7
8
9
10
11
12

3

2 1

Name
Top cover
Power switch
Tray 1
Multipurpose (MP) tray
Top cover open button
Operator panel
Auto document feeder (ADF) cover
Document tray
Scanner unit
Document glass cover
Air vents
USB port

14
15
16
17

20

18
19

No.
14
15
16
17
18
19
20
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Name
Fuser unit
Toner cartridge (Y: yellow)
Toner cartridge (M: magenta)
Toner cartridge (C: cyan)
Toner cartridge (K: black)
Image drum unit
LED head (four heads)

Names of Components

1

LINE TEL
25

24

Machine Setup

21
22
23

No.
21
22
23
24

25

Name
Faceup stacker
AC power socket
Air vents
LINE connection (for MC342dn/MC342dw/
MC362dn/MC362w/ MC562dn/MC562w/
MC562dw/ES5462 MFP/ES5462dw MFP/
MPS2731mc only)
TEL connection (for MC342dn/MC342dw/
MC362dn/MC362w/MC562dn/MC562w/
MC562dw/ES5462 MFP/ES5462dw MFP/
MPS2731mc only)

26
28
27

MC562dn/MC362dn/MC352dn/
MC332dn/ES5462/ES3452

27
28
26

MC562dw/MC362w/MC342w/
ES5462dw/MPS2731mc

No.
26
27
28

Name
USB interface connection
Network interface connection
SD memory card slot
(for MC562dn/MC562w/MC562dw/ES5462 MFP/
ES5462dw MFP/MPS2731mc only)
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Names of Components

1

Operator Panel
The following shows the names of the components of the operator panel.

Machine Setup

Reference

●● For the details on the functions of each component, refer to the User’s Guide > “Introduction” > “Control panel”.

22

2

1

16 11

6

7

8 9

10

21

20

13

19

No.
1
2

3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22

15

12

14

17

3

4

Name
Display screen
Main function keys
<COPY> key
<SCAN> key
<PRINT> key
<FAX> key
(for MC342dn/MC342dw/MC362dn/MC362w/MC562dn/
MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc)
<START (MONO)> key
<START (COLOR)> key
<STOP> key
<STATUS> key
<SETTING> key
<?HELP> key
<RESET/LOG OUT> key
Ten-key pad
<UP> key
<DOWN> key
<LEFT> key
<RIGHT> key
<OK> key
<BACK> key
<CLEAR> key
<POWER SAVE> key
<DATA IN MEMORY> indicator
(for MC342dn/MC342dw/MC362dn/MC362w/MC562dn/
MC562w/MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc)
One-Touch key pad
<JOB MACRO> key
(for MC562dn/MC562w/MC562dw/ES5462 MFP/
ES5462dw MFP/MPS2731mc)
Qwerty keyboard
(for MC562dn/MC562w/MC562dw/ES5462 MFP/
ES5462dw MFP/MPS2731mc)
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18

Installing Your Machine

●●
Installing Your Machine

1

This section explains how to unpack and install the machine.

Installation Space

This section explains the required environment
and space for machine installation.

Install your machine on a flat surface that is
wide enough to accommodate the machine.

Installation Environment

Allow for enough room around your machine
according to the images below.

Your machine must be installed in the following
environment:

●● Top view
20cm

Temperature:
Humidity:
Maximum wet bulb
temperature:

10°C~32°C
20%~80% RH (relative
humidity)
25°C

60cm

100cm
20cm

Note

●● Be careful of condensation. It may cause a malfunction.
●● If installing your machine where the relative humidity of
the surrounding air is less than 30%, use a humidifier or
antistatic mat.

●● Side view
60cm

WARNING
●● Do not place in hot locations or near fire.
●● Do not install in locations where chemical
reactions take place (laboratory etc.).
●● Do not place in locations near flammable solutions
such as alcohol and thinner.
●● Do not place in locations within reach of small
children.
●● Do not install in unstable locations (wobbly stand,
angled place, etc.).
●● Do not install in locations with high humidity or
dust and where exposed to direct sunlight.
●● Do not install in an environment exposed to briny
air and corrosive gas.
●● Do not install in locationss with much vibration.
●● Do not install in locations where the ventilation
holes of the machine are blocked.

CAUTION
●● Do not place directly on a rug or carpet with long
strands.
●● Do not install in a closed room with poor
ventilation or circulation.
●● If you use the machine in a small room for a long
time, please make sure that you ventilate the
room.
●● Install away from strong magnetic fields and
sources of noise.
●● Install away from monitors or TVs.
●● When moving the machine, hold it on both sides,
and move it by slightly tilting the back down.
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Installation Requirements

Installing Your Machine

1
Machine Setup

●● Infrastructure mode
This mode communicates through the wireless
access point. This product does not support
the ad-hoc mode in which communication is
performed directly with the computer.

Wireless LAN Environment
(MC342dw, MC362w, MC562w,
MC562dw, ES5462dw MFP,
MPS2731mc only)
This product connects wirelessly to a wireless
access point, and can then be used on the network.
MFP

Wireless access point
PC

Precautions for use in a wireless
LAN environment
●● This product cannot connect to a wired LAN
and wireless LAN at the same time. While
using wireless LAN, please remove network
cable from the device.
●● Check the wireless access point settings
before configuring the SSID and security
settings. This product cannot connect to the
LAN if the settings are wrong.
●● This product supports infrastructure mode.
Ad-hoc mode is not supported.

Terminology
●● SSID
An ID used to identify the connection destination
network. Wireless communication can be used
by setting this product with the SSID of the
connection destination wireless access point.
●● Security Settings
When using a wireless LAN, security settings
can be configured to prevent the transmitted
information from being intercepted or illegal
access to the network. The security settings
need to be configured to the same settings as
the wireless access point.
●● WPS
A wireless LAN setting method provided
by Wi-Fi Alliance, a wireless LAN industry
group. There are two available methods, a
push button method and PIN code method,
and in the push button method the wireless
LAN settings can easily be configured simply
by pressing a [WPS] button on the wireless
access point. In the PIN code method, the
wireless LAN settings can easily be configured
by registering the 8-digit number assigned to
this product to the wireless access point.
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Installing Your Machine

3

Unpacking and Installing Your
Machine

Remove the protection tapes (2) at the
top and sides of your machine, and take
out cushioning materials (3).
2

Note

●● The image drum is very delicate. Handle it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

3

●● Packaging and cushioning material are needed if
transporting the machine. Do not throw them away.

1

Remove your machine from the box and
remove cushioning materials and the
plastic bag from your machine.

2

The accessories (an AC cord, Telephone cable and
the “Software DVD-ROM”) are packed within the
cushioning material (1).

4

Remove the protection tapes (4), and
open the MP tray.

Note

●● Telephone cable is not supplied in some countries.

4

5

Remove the protection tape (5), and pull
the paper up.

1

2

5

Lift your machine and place it where it is
to be installed.
Note

●● Do not open the scanner unit till step 9 is completed.

6

Close the MP tray.

7

Open the document glass cover.
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Machine Setup

This section explains how to unpack and install
the machine.

1

Installing Your Machine

1

8

Remove the protection tapes (6).

12 Press the top cover open button (8) and
open the top cover.

Open the ADF and remove the protection tapes.

Machine Setup

6

8

9

Close the document glass cover.

13 Remove the protective sheets (9).

Now, you can open or close the scanner.

10 Open the scanner unit.
9

11 Remove the protection tapes (7), and

14 Remove the orange stopper (11) while

pressing the blue lever of the fuser unit
(10) in the direction of the arrow.

remove desiccants and films.

10

9

11

7

Note

●● Keep the orange stopper, it is necessary to transport
the machine.
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Installing Your Machine

15 While pushing the right side of the toner

12

Available Options
The following option is available for your
machine:
●● Second tray unit (tray 2) (MC362dn/MC362w/
MC562dn/MC562w/MC562dw/ES5462 MFP/
ES5462dw MFP/MPS2731mc only)
●● Additional RAM (256 MB or 512 MB)
●● 16 GB SD card (MC562dn/MC562w/MC562dw/
ES5462 MFP/ES5462dw MFP/MPS2731mc
only)
Reference

●● For details on how to install the option, refer to the User’s
Guide > “Installing upgrades”.
●● An SD card is used as a storage for spooling when copying
sectors, saving secure print/encrypted print data, as a
storage destination for form data, and for saving auto
delivery and transmission data.

16 Close the top cover.

For information on secure print, encrypted secure print,
form data, and auto delivery/transmission data storage
functions, please refer to Configuration Guide.

17 Close the scanner unit.

Memo

Reference

●● Please refer to “Loading Paper” P.20 for information on
how to load paper into the machine.

●● There is a 4 GB SD card inside the MC562dn/MC562w/
MC562dw/ES5462 MFP/ES5462dw MFP/MPS2731mc.
If you expand the memory capacity, please replace with
an optional 16 GB SD card.
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Machine Setup

cartridge, quickly slide the blue lock (12)
to the left side to lock it.
Slide the locks on all 4 toner cartridges.

Installing Your Machine

1

Turning Your Machine On and
Off

WARNING

Machine Setup

This section explains how to turn the machine on
and off.

Power Supply Conditions
The power supply must meet the following
conditions:
Current:

110 - 127VAC
(Range 99 - 140VAC)
220 - 240VAC
(Range 198 - 264VAC)

Frequency:

50/60 Hz ± 2%

Note

●● If the power supply is unstable, use a voltage regulator.
●● The maximum power consumption of this machine is
1170W. Ensure that the power supply is sufficient to
operate this machine.
●● We do not guarantee the operation where an
uninterruptible power system (UPS) or inverter is used.
Do not use an uninterruptible power system (UPS) or
inverter.
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There is a risk of electric
shock and/or fire.

●● Be sure to turn off the power switch when
attaching or removing the AC cable and earth
wire.
●● Be sure to connect the earth wire to a dedicated
grounding terminal.
●● Never connect the earth wire to a water pipe, gas
pipe, telephone line earth, lightning rod or the
like.
●● Make sure to connect the earth wire before
connecting the AC cable to the electric socket.
●● Be sure to plug in and unplug the AC cable while
holding on to the power supply plug.
●● Insert the power supply plug deep into the wall
socket securely.
●● Do not insert or remove the power supply plug
with a wet hand.
●● Install the power cord in a place where it will not
be stepped on, and do not place anything on the
power cord.
●● Do not tie the cord in a bundle.
●● Do not use the power cord if damaged.
●● Do not use multi-outlet adapters.
●● Do not connect this machine and other electric
items to the same wall socket. If connected
simultaneously with an air-conditioner unit, a
copy machine, shredder, etc., electric noise may
interfere with machine operation. If connection
to the same wall socket as another item is
unavoidable, please use a commercial noise filter
or a commercial noise cut transformer.
●● Use the attached power cord and insert it directly
with the ground terminal. Do not use power cords
for other products for the machine.
●● Do not use an extension cord. When use of an
extension cord is unavoidable, use a cord rated
15A or higher.
●● Use of an extension cord may cause the machine
to operate at lower than normal capacity due to
AC voltage descent.
●● During printing, do not shut off the power supply
or remove the power supply plug.
●● When not in use for extended periods
(consecutive holidays or extended travel), remove
the power cord from the socket.
●● Do not use the attached power cord for other
products.

Installing Your Machine

Turning Off Your Machine

1

Plug the AC cord into the AC power
socket of your machine.

1

2

Plug the AC cord into the electric socket.

3

Check that no documents are on the
document glass or ADF, and that the
ADF cover is closed.

4

Hold down the power switch for
approximately one second.

Note

●● Press the power switch for less than 5 seconds.

The message [Shutdown in progress. Please
wait. The machine turns off automatically.]
will appear in the operator panel, and power
switch indicator will blink every 1 second. The
machine then turns off automatically and the
power switch indicator extinguishes.

Hold down the power switch for approximately
one second to turn the power on.

Note

●● Wait a few seconds after turning the power on or off
before turning the power on or off again.
Reference

●● Your machine has a power save mode and sleep mode,
and an auto power off function. For details, refer to the
User’s Guide > “Getting started” > “Power saving mode” /
“Sleep mode” / “Auto power off”.

The copy standby screen is displayed after your
machine attains ready status.

Note

●● Wait a few seconds after turning the power on or off
before turning the power on or off again.
●● With wireless LAN models, a request to make the wireless
LAN settings is displayed before the standby screen.
Select [Yes] to perform the wireless LAN Set-up or select
[No (Do not show next time.)] for not to be displayed
from the next time. (MC342dw, MC362w, MC562w,
MC562dw, ES5462dw MFP, MPS2731mc only)
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Turning On Your Machine

Installing Your Machine

1

Loading Paper
Your machine has two built-in trays (tray 1 and MP tray) and an optional tray (tray 2).

Machine Setup

The Option Tray (tray 2) is only available on MC362dn, MC362w, MC562dn, MC562w, MC562dw,
ES5462 MFP, ES5462dw MFP and MPS2731mc.
This section explains the supported paper and capacity of tray 1 and how to load paper into the tray 1.
After you load paper, you need to register the loaded paper on your machine.
To complete the loading procedures, follow the 2 steps below:
●● “Step 1 Loading Paper into Tray 1” P.20
●● “Step 2 Configuring the Settings for Tray 1” P.21

 Tray 1 Specification
Supported paper size
●● A4
●● A5*
●● B5
●● A6*
●● Letter
●● Legal 13
●● Legal 13.5
●● Legal 14
●● Executive
●● 16K (184 x 260 mm)
●● 16K (195 x 270 mm)
●● 16K (197 x 273 mm)
●● Hagaki
●● Custom

Paper capacity

Paper weight

250 sheets

●● Light

(when paper weight is 80 g/m2)

64 to 74 g/m2 (17 to 19 lb)
●● Medium Light
●● Medium

75-82g/m2

83-104g/m2

●● Heavy
105 to 120 g/m2 (28 to 32 lb)
●● Ultra Heavy1
121 to 176 g/m2 (33 to 46 lb)
●● Ultra Heavy2
177 to 220 g/m2 (47 to 58 lb)

Note

●● Duplex printing cannot be performed on paper marked with “*”.
Reference

●● For the specifications and how to load paper in tray 2 (optional), MP tray, refer to the User’s Guide > “Loading paper”.

Step 1 Loading Paper into Tray 1
1

2

Slide the paper guide (1) to the width of
the paper to be loaded.

Pull out tray 1.
1

3

Slide the paper stopper (2) to the length
of the paper to be loaded.
2

Note

●● Once the tray is pulled out, the media selection
screen will be displayed on the panel (for
approximately 6 seconds). Further configuration of
item 4 in Step 2 is possible.
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Flex paper back and forth, and then fan
it. Straighten the edges of the paper
stack on a level surface.

5

Load paper with the print side face
down.
Note

●● Do not load paper above the fill line (3).

2

Press the to select [Paper Setup] and
then press OK .

3

Check that [Tray 1] is selected and then
press OK .

4

Check that [Paper Size] is selected and
then press OK .

5

Press the to select the size of the
loaded paper and then press OK .
Reference

●● If [Custom] is selected for [Paper Size], you need
to register the custom size. For how to register the
custom size, refer to the User’s Guide > “Loading
paper” > “Registering custom sizes”.

[▼▼▼]

6

3

Press the to select [Media Type] and
then press OK .

7

Press the to select the type of media
loaded and then press OK .

8

Press the to select [Media Weight]
and then press OK .

9

Press the to select the weight of the
loaded paper and then press OK .

Push tray 1 until it stops.

Step 2 Configuring the Settings for
Tray 1
1

6

10 Press the

displayed.

Press the <SETTING> key on the
operator panel.
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until the top screen is

1
Machine Setup

4

Printing Configuration

1

●●
Printing Configuration

Machine Setup

This section explains how to print the Configuration on which you can check the detailed information of
your machine, such as the settings and status of your machine.
When you finished the initial setup, follow the procedure below to confirm that the machine is properly
installed.

Printing Procedure
1

Press the <SETTING> key on the
operator panel.

2

Check that [Reports] is selected and
press OK .

3

Check that [Configuration] is selected
and press OK .

4

For the confirmation message, check
that [Yes] is selected and press OK .
When the Configuration is properly printed, the
initial setup has succeeded.
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2 Copying
This chapter explains the basic operation for your machine’s copy function.

Starting a Copy Job

●● Document Glass
Place the document face down and align its top
edge to the upper-left corner of the glass.

Memo

Copying

●● The following procedure uses the factory default settings.

1

Press the <COPY> key on the operator
panel to open the copy standby screen.

Close the document glass cover gently.
Note

●● Do not apply an excessive load to the document
glass.

2

2

Place your document in the ADF or on
the document glass as below:
●● ADF
Load documents face up with the top edge of the
documents in first.

Memo

●● The machine prioritizes the ADF when copying
documents. Be sure not to place documents on the
ADF when you use the document glass.
Note

●● If Carriage Error <02> is displayed, press Power
OFF/ON.

Adjust the document guides to the width of your
documents.
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3

Starting a Copy Job

Press

MONO

or

COLOR

to start copying.

Memo

2

●● You can cancel the operation by pressing the
<STOP> key on the operator panel until the
message showing the copy completion is displayed.

Copying
Reference

●● To load a landscape document, refer to the User’s Guide >
“Operation” > “Loading document(s)”.
●● You can change the copy settings such as scan size,
document’s orientation and duplex copying as necessary.
For details, refer to the User’s Guide > “Copying” >
“Advanced operation”.
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3 Faxing (For MC342dn, MC342dw,
MC362dn, MC362w, MC562dn, MC562w,
MC562dw, ES5462 MFP, ES5462dw MFP,
MPS2731mc only)
This chapter explains the initial setup, such as how to set the country code, connect a telephone line
and configure the basic settings, and basic procedure for the Fax and Fax from Computer functions.

Function
“Faxing”
“Faxing from a Computer
(For Windows)”

Internet Faxing

Auto Delivery
(MC562dn/MC562w/
MC562dw/ES5462
MFP/ES5462dw MFP/
MPS2731mc only)

Overview
Scans documents and transmits them as faxes or receives faxes via a telephone line.
You need to complete the initial setup for faxing before using this function.
Transmits faxes from your computer connected via USB or network. The faxes are
transmitted directly from your computer to a destination via the machine using a
telephone line. The fax driver must be installed on the computer to use this function.
You also need to complete the initial setup for faxing before using this function.
Scans documents and transmits them as faxes or receives faxes by e-mails via
network.
For the initial setup for the function, refer to the Configuration Guide > “Configuring
the network settings” > “Setting up Scan to E-mail and internet fax”.
For the procedure for the function, refer to the User’s Guide > “Internet fax” >
“Sending a fax from your PC” > “Basic operation”.
Forwards the received faxes and files attached to e-mails automatically to specified
destinations. You can specify E-mail addresses and a network folder as the
destination.
For the initial setup for the function, refer to the Configuration Guide > “Configuring
the network settings” > “Setting up Scan to E-mail and internet fax” / “Setting up
Scan to Shared Folder”.
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Your machine supports the following functions regarding fax.

3

Initial Setup for Faxing

●●
Initial Setup for Faxing
This section explains the initial setup necessary for the Fax and Fax from Computer functions.
To set up the machine for the Fax and Fax from Computer functions, follow the 3 steps below:
●● “Step 1 Setting Country Code” P.26
●● “Step 2 Connecting a Telephone Line” P.27
●● “Step 3 Configuring Basic Settings” P.31

3

Step 1 Setting Country Code

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
MC562w, MC562dw, ES5462 MFP, ES5462dw MFP, MPS2731mc only)

3

Press the to select [Admin Setup]
and then press OK .

4

Enter the administrator password.

This section explains how to set the country
code. Be sure to select the suitable country code
before connecting the telephone line.
Note

●● If you set wrong country code, you may not be able to
send or receive faxes. When you cannot send or receive
faxes even though you have properly connected the
telephone line, check if [Country Code] is set correctly.

1

2

Hold down the power switch for
approximately one second to turn on the
power.

Press the <SETTING> key on the
operator panel.

The factory default password is “aaaaaa”.

a

Press , , , to select the
character you want, and then
press OK .

-- The selected character is entered as “*” in
the text filed.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.
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b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

OK

to select [Enter]

Initial Setup for Faxing

5

Press the to select [Fax Setup] and
then press OK .

6

Press the to select [Fax Setting] and
then press OK .

7

Press the to select [Country Code]
and then press OK .

8

Press the or to select your country
name and then press OK .

-- If your country is the Czech Republic or
Slovakia, select [Czech/Slovakia].
-- If your country is Canada, select [U.S.A].
-- If the region of your country is Latin
America, select [Latin America].
-- If the region of your country is Europe or
the Middle East, select [International].
Settable Country Codes:
U.S.A. International United Kingdom
Ireland Norway Sweden Finland
Denmark Germany Hungary
Czech/Slovakia Poland Switzerland
Austria Belgium Netherlands France
Portugal Spain Italy Greece
Australia New Zealand Singapore
Hong Kong Latin America Mexico
China Russia Taiwan Japan Korea
Thailand Malaysia Jordan Argentina
Brazil South Africa Belarus Moldova
Turkey Ukraine

9

This section explains how to connect a telephone
line for faxing. Be sure to connect the telephone
line depending on your environment before you
transmit or receive faxes.
The method of connecting a telephone line
differs depending on your environment. Based
on the following figures, connect the line for
your environment.
Note

●● Do not connect with USB cable or LAN cable at this point.
●● Be sure to set the appropriate country code before
connecting the telephone line.
●● You cannot connect to an ISDN line directly. To connect to
an ISDN line, use the terminal adopter (TA) and connect
to the LINE connection of the machine.
●● A telephone cable is supplied with your machine except in
certain countries.
Reference

●● To check the reception mode according to the machine
environment, refer to “Step 3-6 Specifying Reception
Mode” P.37.
●● To check the dial type settings, refer to “Step 3-1 Settings
for Each Dialing Type” P.31.

Connecting to a Public Line
(Connecting for Fax Only)
Note

●● Do not connect with USB cable or LAN cable at this point.

1

Check that the machine is turned off.
If the machine is turned on, hold down the power
switch for approximately one second to turn off
the power.

For the confirmation message, check
that [Yes] is selected and press OK .
The machine restarts automatically, and the
default screen is displayed a few minutes later.
Memo

●● If the [Country Code] is changed, the value of [PBX
Line] and [MF (Tone)/DP (Pulse)] are changed to the
default values for each country code.
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If your country name is not displayed, select the
following value.

Step 2 Connecting a
Telephone Line

Initial Setup for Faxing

2

3

Plug one end of the [Telephone cable]
into the [LINE connection] of your
machine and the other end into the
[Public Line (Analog)].

Remove the [Telephone connector
cover].
TEL
E
LIN

LINE connection

Telephone connector cover

3

4

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
MC562w, MC562dw, ES5462 MFP, ES5462dw MFP, MPS2731mc only)

Public Line
(Analog)

Plug the external telephone’s cable into
the [TEL connection] of your machine.
TEL connection

Telephone cable
Note

●● Be certain to connect the telephone cable to [LINE
connection]. Never connect it to [TEL connection].

Connecting to a Public Line
(Connecting for Fax and Telephone)
●● Do not connect with USB cable or LAN cable at this point.

The telephone that is connected to the machine
is called an external telephone.

1

●● Only one telephone can be connected to the machine.

Note

Note

Check that the machine is turned off.
If the machine is turned on, hold down the power
switch for approximately one second to turn off
the power.

2

●● Do not connect the telephone to the machine in parallel.
If you connect the telephone to the machine in parallel,
the following problems will occur and the machine will not
work correctly.

Plug one end of the [Telephone cable]
into the [LINE connection] of your
machine and the other end into the
[Public Line (Analog)].

--When you send or receive a fax, the fax picture may
be broken or a communication error may occur by
picking up the telephone.
--The fax transfer function is not able to work from the
external telephone.
Public Line (Analog)

Public Line (Analog)

first floor second floor

LINE connection

Public Line
(Analog)

Memo

Telephone cable

●● In the case of direct interconnection, separate
construction is necessary. Please contact the telephone
company that you use.
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Connecting to an ADSL Environment

Connecting to an IP Telephone

Note

Note

●● Do not connect with USB cable or LAN cable at this point.

First, check that the machine is turned off. If
the machine is turned on, hold down the power
switch for approximately one second to turn off
the power.

First, check that the machine is turned off. If
the machine is turned on, hold down the power
switch for approximately one second to turn off
the power.

Plug the [Telephone cable] connected to the
ADSL modem into the [LINE connection] of
your machine.

Plug the [Telephone cable] connected to the
IP telephone into the [LINE connection] of
your machine.

Remove the telephone connector cover.

Remove the telephone connector cover.

Plug the external telephone’s cable into the [TEL
connection] of your machine.

Plug the external telephone’s cable into the
[TEL connection] of your machine.

LINE connection

TEL connection

LINE connection

TEL connection

Optical IP telephone
Corresponding
telephone
Optical Network
Unit (ONU)

Public Line
(Analog)
Telephone cable
Telephone cable

Splitter

LAN
cable

Optical cable

*Insert into the
telephone cable jack.

ADSL modem
Memo
Memo

●● Check the dial tone detection if it is unable to dial. Refer to
the Configuration Guide > “Appendix A - menu system” >
“Admin Setup” > “User Install”.
●● If you cannot send or receive faxes very well, set [Super
G3] to [OFF]. Refer to “Step 3-5 Setting for Super G3”
P.36 in detail.

●● Check the dial tone detection if it is unable to dial. Refer to
the Configuration Guide > “Appendix A - menu system” >
“Admin Setup” > “User Install”.
●● If you cannot send or receive faxes very well, set [Super
G3] to [OFF]. Refer to “Step 3-5 Setting for Super G3”
P.36 in detail.
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●● Do not connect with USB cable or LAN cable at this point.

Initial Setup for Faxing

Connecting to a CS Tuner or Digital
Television

Connecting to a PBX, Home
Telephone or Business Phone

Note

3

Note

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
MC562w, MC562dw, ES5462 MFP, ES5462dw MFP, MPS2731mc only)

●● Do not connect with USB cable or LAN cable at this point.

●● Do not connect with USB cable or LAN cable at this point.

First, check that the machine is turned off. If
the machine is turned on, hold down the power
switch for approximately one second to turn off
the power.

First, check that the machine is turned off. If
the machine is turned on, hold down the power
switch for approximately one second to turn off
the power.

Plug the [Telephone cable] connected to
the [Public Line (Analog)] into the [LINE
connection] of your machine.

Plug the [Telephone cable] connected to
the [Public Line (Analog)] into the [LINE
connection] of your machine.

Remove the telephone connector cover.

Remove the telephone connector cover.

Plug the telephone cable connected to the
CS tuner or digital television into the [TEL
connection] of your machine.

Plug the telephone cable connected to a
control device including PBX, etc. into the [TEL
connection] of your machine.

LINE connection

LINE connection

TEL connection

CS tuner or digital
television

Telephone cable

TEL connection

Control device
including PBX, etc.

Public Line
(Analog)
Telephone cable

Public Line
(Analog)

●● Home Telephone
In general, many telephones are connected
with one or two telephone lines, and internal
communication and door phone are possible.
This is simple switching equipment for
household.
●● Business Phone
In general, it can accommodate more than
two telephone lines, these telephone lines can
be shared with other telephones, and internal
communication is possible. This is simple
switching equipment.
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Connecting as an Internal Telephone

Step 3 Configuring Basic
Settings

Note

●● Do not connect with USB cable or LAN cable at this point.

This section explains how to configure the basic
settings on the machine for the fax function.
Follow the 6 sub steps below:

First, check that the machine is turned off. If
the machine is turned on, hold down the power
switch for approximately one second to turn off
the power.
Plug the [Telephone cable] connected to a
control device including PBX, etc. into the [LINE
connection] of your machine.

Control device
including PBX, etc.

●● “Step 3-2 Setup of Date/Time” P.32
●● “Step 3-3 Specifying Sender Information”
P.34
●● “Step 3-4 PBX Connecting” P.35
●● “Step 3-5 Setting for Super G3” P.36
●● “Step 3-6 Specifying Reception Mode” P.37
Note

Telephone
cable

●● You need to complete the country code setting and
connect the telephone line according to your environment
before this procedure.
Memo

●● You can skip the steps 3-4 and 3-5 depending on your
environment. For details, refer to each description.

Step 3-1 Settings for Each Dialing
Type

Memo

●● Set [PBX Line] to [ON]. Refer to “Step 3-4 PBX
Connecting” P.35 in detail.

Specify the dialing type for transmission
according to your environment. The factory
default for [MF (Tone)/DP (Pulse)] is set to
[Tone].
●● For push-button phones, if you hear a “Beep,
boop, beep” sound, leave [MF (Tone)/
DP (Pulse)] as [Tone].
●● For push-button type phones, if you do not
hear a “Beep, boop, beep” sound, set
[MF (Tone)/DP (Pulse)] to [Pulse].
●● For rotary-dial type phones, set [MF (Tone)/
DP (Pulse)] to [Pulse].

1
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Press the <SETTING> key on the
operator panel.
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Public Line
(Analog)

LINE connection

●● “Step 3-1 Settings for Each Dialing Type”
P.31

Initial Setup for Faxing

2

Press the
and press

OK

7

to select [Admin Setup],
.

Press the until the top screen is
displayed.

Step 3-2 Setup of Date/Time
Set up Date/Time of your region.

3

3

1

Press the <SETTING> key on the
operator panel.

2

Press the to select [Easy Setup] and
then press OK .

3

Enter the administrator password.

Enter the administrator password.
The factory default password is “aaaaaa”.

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
MC562w, MC562dw, ES5462 MFP, ES5462dw MFP, MPS2731mc only)

a

Press , , , to select the
character you want, and then
press OK .

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

4

b

Repeat step a until all characters
required are entered.

c

Press the
and press

Press the
and press

OK

and
.

The factory default password is “aaaaaa”.

to select [Enter]

OK

to select [User Install],
.

5

Press the to select [MF (Tone)/DP
(Pulse)], and then press OK .

6

Press the to select a dial type, and
then press OK .
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a

8

Press , , , to select the
character you want, and then
press OK .

To move to the next box, press the

9

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

When you press OK , a message showing that
Date/Time setting is complete appears.

10 When the setup menu screen is
displayed, press
setup.

that [Yes] is selected and press

to select [Enter]

Check that [Date/Time Setting] is
selected and then press the .

5

Press the to select the appropriate
time zone and then press OK .

6

Press the to select whether summer
time is applied or not and then press OK .

7

Check that [Manual] is selected and
then press OK .

to complete the

11 For the confirmation message, check

OK

4

.
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b

.

Press the or to select the current
time and then press OK .
To move to the next box, press the

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

Press the or to select the current
date and then press OK .

Initial Setup for Faxing

Step 3-3 Specifying Sender
Information

a

Specify the fax number and sender name for
your machine. The information specified here is
printed on the top of the faxes you sent from the
machine.

1

3

Press , , , to select the
character you want, and then
press OK .

Press the <SETTING> key on the
operator panel.

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
MC562w, MC562dw, ES5462 MFP, ES5462dw MFP, MPS2731mc only)

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

2

Press the
press OK .

3

Enter the administrator password.

to select [Easy Setup] and

The factory default password is “aaaaaa”.

b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

to select [Enter]

OK

4

Press the to select [Fax Setting] and
then press the .

5

Press to select the [Fax Number]
entry box.
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6

Step 3-4 PBX Connecting

Enter the fax number of your machine
with the ten-key pad.

When connecting to PBX (internal exchange), set
[PBX Line] to [ON].

1

Press the <SETTING> key on the
operator panel.

3

Check that [Enter] is selected and then
press OK .

8

Press
box.

9

Enter an arbitrary sender name up to 22
characters allowed.

Press the to select [Admin Setup]
and then press OK .

3

Enter the administrator password.

to select the [Sender ID] entry

10 Press the

and
then press .

to select [Enter] and

The default password is “aaaaaa”.

OK

The message showing that fax setting is complete
appears.

11 When the setup menu screen is
displayed, press
setup.

to complete the

12 For the confirmation message, check
that [Yes] is selected and press

OK

.
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a

Press , , , to select the
character you want, and then
press OK .

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
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7

2

Initial Setup for Faxing

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

Step 3-5 Setting for Super G3
If you cannot send or receive faxes correctly
when the machine is connected to the ADSL
environment or an IP telephone, set [Super G3]
to [OFF].

1

Press the <SETTING> key on the
operator panel.

2

Press the to select [Admin Setup]
and then press OK .

3

Enter the administrator password.

3
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b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

to select [Enter]

OK

4

Press the to select [Fax Setup] and
then press OK .

5

Press the to select [Fax Setting] and
then press OK .

6

Press the to select [PBX Line] and
then press OK .

7

Press the
press OK .

8

Press the until the top screen is
displayed.

to select [ON] and then

The default password is “aaaaaa”.

a
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Press , , , to select the
character you want, and then
press OK .

Initial Setup for Faxing

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

Step 3-6 Specifying Reception Mode
The optimal reception mode differs depending
on your machine’s environment. Check with the
following description.
●● Fax Ready Mode
This mode is recommended when you use the
machine as a fax machine.

●● Tel/Fax Ready Mode
This mode is recommended when you connect an
external phone to the machine.

This mode is recommended when you connect an
external answering machine to the machine.

b
c

Repeat step a until all characters
required are entered.

●● Tel Ready Mode

Press the
and press

●● DRD

and
.

to select [Enter]

OK

4

Press the to select [User Install] and
then press OK .

5

Press the to select [Super G3] and
then press OK .

6

Press the
press OK .

7

Press the until the top screen is
dislpayed.

This mode is recommended when you mainly use
an external phone connected to the machine.

This mode is recommended when you use the
distinctive ring detection (DRD) function provided
by a telephone company.

1

Press the <SETTING> key on the
operator panel.

2

Press the
and press

to select [OFF] and then

3

OK

to select [Admin Setup]
.

Enter the administrator password.
The factory default password is “aaaaaa”.
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●● Ans/Fax Ready Mode

3

Initial Setup for Faxing

a

Press , , , to select the
character you want, and then
press OK .

3
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-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

b

Repeat step a until all characters
required are entered.

c

Press the
and press

4

Press the
press OK .

5

Press the
and press

6

Press the
and press

and
.

to select [Enter]

OK

to select [User Install] and

OK

OK

to select [Reception Mode]
.
to specify a reception mode
.

Settable Reception Mode:
Fax Ready Mode*
Tel/Fax Ready Mode
Ans/Fax Ready Mode Tel Ready Mode
DRD
*indicates the factory default.

7

Press the until the top screen is
displayed.
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●●
Faxing
This section explains the basic procedure for the Fax function.
The Fax function enables you to scan documents and transmit them as faxes or receive faxes via a
telephone line.
Be sure to finish the initial setup before using this function.

Procedure for Fax

●● Document Glass
Place the document face down and align its top
edge to the upper-left corner of the glass.

You need to configure the initial settings before
using the Fax function.
Note

●● Up to 40 digits can be entered for the destination fax
number.
Memo

●● You can load only A4, letter, or legal size documents in
the ADF, and A4 or letter size documents on the document
glass.
●● You cannot load mixed size documents for faxing.

Close the document glass cover gently.

●● The following procedure uses the factory default settings.

Note

1

Press the <FAX> key on the operator
panel.

2

Place your document in the ADF or on
the document glass as below:

●● Do not apply an excessive load to the document
glass.

Memo

●● The machine prioritizes the ADF when scanning
documents. Be sure not to place documents on the
ADF when you use the document glass.

●● ADF

Note

Load documents face up with the top edge of the
documents in first.

●● If Carriage Error <02> is displayed, press Power
OFF/ON.

3

Adjust the document guides to the width of your
documents.
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Check that [Fax] is selected and
press OK to open the fax start screen.

3
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This section explains how to transmit faxes. The
following procedure uses the direct input method
for specifying a destination.

Faxing

4

Check that [Add Destination] is
selected on the start screen and then
press OK .

8

Press

MONO

to start transmission.

Note

●● You cannot use the

COLOR

button.

is pressed
●● If the <STATUS> key is pressed and
twice, the information is displayed on the display
screen.
Memo

3

●● When you want to cancel the operation during the
transmission, press the <STOP> key on the operator
panel.

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
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5

Press the to select [Direct Input] and
then press OK .

6

Enter a destination fax number up to
40 digits using the ten-key pad on the
operator panel.
Reference

●● In addition to inputting the destination directly, you can
use the speed dial list, group list, transmission histories,
reception histories, or One-Touch key pad to specify the
destination. For details, refer to the User’s Guide >
“Faxing - MC342dn, MC342dw, MC362dn, MC362w,
MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw
MFP and MPS2731mc only” > “Managing the phone book”.
●● To load a landscape document, refer to the User’s Guide >
“Operation” > “Loading document(s)”.

Reference

7

●● For dialing functions such as hyphen, prefix and
flash, refer to the User’s Guide > “Faxing - MC342dn,
MC342dw, MC362dn, MC362w, MC562dn, MC562w,
MC562dw, ES5462 MFP, ES5462dw MFP and
MPS2731mc only” > “Sending a fax from the MFP” >
“Advanced operation”.

●● You can change the fax settings such as document size
and resolution as necessary. For details, refer to the
User’s Guide > “Faxing - MC342dn, MC342dw, MC362dn,
MC362w, MC562dn, MC562w, MC562dw, ES5462 MFP,
ES5462dw MFP and MPS2731mc only” > “Sending a fax
from the MFP” > “Advanced operation”.

Check that [Enter] is selected and then
press OK .

●● When you want to specify multiple destinations, refer
to the User’s Guide > “Faxing - MC342dn, MC342dw,
MC362dn, MC362w, MC562dn, MC562w, MC562dw,
ES5462 MFP, ES5462dw MFP and MPS2731mc only” >
“Sending a fax from the MFP” > “Advanced operation”.
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Printing Received Faxes

Receiving a Fax
This section explains how your machine behaves
when the machine whose reception mode is set
to [Fax Ready Mode] is receiving and printing
faxes.
Reference

Reception Behavior
Your machine is set by factory default to [Fax
Ready Mode] so that it automatically receives
faxes.
When the machine is receiving faxes, the
<DATA IN MEMORY> indicator is lit. If the
<STATUS> key is pressed and is pressed
twice, the information is displayed on the display
screen. Even if the reception is finished, the
indicator remains lit while the data is stored in
memory.

Note

●● Do not pull out the paper trays when the machine is
printing.
Memo

●● Use only standard or recycled paper.
●● Available paper sizes are A4, letter, or legal.
Reference

●● Images larger than the specified paper are reduced,
discarded, or printed onto multiple sheets of paper
depending on the reception print settings. For details,
refer to the User’s Guide > “Faxing - MC342dn, MC342dw,
MC362dn, MC362w, MC562dn, MC562w, MC562dw,
ES5462 MFP, ES5462dw MFP and MPS2731mc only” >
“Sending a fax from the MFP” > “Fax receiving” >
“Printing received faxes”.
●● If you want to use another paper tray to print received
faxes, refer to the User’s Guide > “Appendix A - menu
system” > “Paper setup” > “Select Tray”.

Memo

●● If the memory is exceeded while the machine is receiving
data, the reception is cancelled. If this happens, print the
data stored in memory or wait until the stored sending/
receiving job finishes, and then ask the sender to resend
the fax.
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●● For the machine behavior when the reception mode is
set to other than [Fax Ready Mode], refer to the User’s
Guide > “Faxing - MC342dn, MC342dw, MC362dn, MC362w,
MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw MFP
and MPS2731mc only” > “Sending a fax from the MFP” >
“Fax receiving”.

The machine automatically prints out the
received fax. By factory default, tray 1 is set to
be used.

Faxing from a Computer (For Windows)

●●
Faxing from a Computer (For Windows)
This section explains how to install a fax driver and the basic procedure of sending a fax from a
computer. The fax driver allows you to send faxes directly from your computer to a destination via the
machine without printing the document.
Be sure to install the fax driver for MC342dn, MC342dw, MC362dn, MC362w, MC562dn, MC562w,
MC562dw, ES5462 MFP, ES5462dw MFP or MPS2731mc before faxing from a computer.
Note

3

●● You need to finish the initial setup before using this function.

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
MC562w, MC562dw, ES5462 MFP, ES5462dw MFP, MPS2731mc only)

Installing a Fax Driver

Step 1 Configuring the Network
Settings of Your Machine

This section explains how to install a fax driver
on your computer as the initial setup for Fax
from Computer function.

Connect your machine to a network with an
Ethernet cable or Wireless LAN connection
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only), and then
configure the machine’s IP address and other
network information from the operator panel.
You can set the IP address either manually or
automatically.

 Overview
Connecting Methods
You can select either of the following connection methods:

If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or machine.

●● “For Network Connection” P.42
●● “For USB Connection” P.48

If your network administrator or internet
service provider specifies a unique IP address
for the computer and your machine, set the IP
addresses manually.

Product Requirements
Your machine supports the following Windows
operating systems:
●● Windows 8/Windows 8 (64bit Version)

Note

●● Windows Server 2012

●● When setting an IP address manually, ask the network
administrator or your internet service provider which IP
address to use. If the IP address is set incorrectly, the
network may go down or Internet access may be disabled.

●● Windows 7/Windows 7 (64bit Version)
●● Windows Vista/Windows Vista (64bit Version)
●● Windows Server 2008 R2

●● Conform the IP version of the machine to that of your
computer.

●● Windows Server 2008/Windows Server 2008
(x64 Version)

●● Set [TCP/IP] setting to [Enable] on your machine. (By
factory default, it is set to [Enable].)
Memo

●● Windows XP/Windows XP (x64 Version)

●● If configuring a small network consisting of only your
machine and a computer, set IP addresses as shown
below (according to RFC1918).

●● Windows Server 2003/Windows Server 2003
(x64 Version)

For the computer

 For Network Connection

IP address :

To install a fax driver on your computer via the
network connection, follow the 2 steps below:
●● “Step 1 Configuring the Network Settings of
Your Machine” P.42

192.168.0.1~254

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

For the machine

●● “Step 2 Installing a Fax Driver” P.46

IP Address Set :

Manual

IPv4 Address :

192.168.0.1~254
(select a different value
from the computer)

Subnet Mask :

255.255.255.0

Gateway Address :

0.0.0.0

Network Scale :

Small

Note

●● You need to complete the network setting of the computer
before this procedure.
Memo

●● You can skip the step 1 if the IP address is already set on
your machine.
●● You can skip the step 2 if the fax driver is already installed
on your computer.

●● To set [Network Scale], press the <SETTING> key
and then select [Admin Setup] > [Network Menu] >
[Network Setup] > [Network Scale].
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4

Connecting using wired LAN:

1

Prepare an Ethernet cable and a hub.

Plug the other end of the Ethernet cable
into the hub.

Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

2

3

5

3

Hold down the power switch for
approximately one second to turn on the
power.

Plug one end of the Ethernet cable into
the network interface connection on the
back of the machine.

Connecting using wireless LAN
(MC342dw, MC362w, MC562w,
MC562dw, ES5462dw MFP, MPS2731mc
only):
Use the WPS (push button) function to set the
wireless LAN. For details on other methods
for setting the wireless LAN, refer to the
Configuration Guide.

1

Press the <SETTING> key on the operator
panel.

2

Press the to select [Wireless Setting],
and then press the .
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Hold down the power switch for
approximately one second to turn off the
power. And turn off your computer.

Faxing from a Computer (For Windows)

3

Log in by entering administrator password
of the device.
Use , ,
press OK .

,

7

key to select letter and then

If [Yes] is selected in step 6, [Running
pushbutton method...] is displayed in
the screen.

Default administrator password is “aaaaaa”.

3

Note

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
MC562w, MC562dw, ES5462 MFP, ES5462dw MFP, MPS2731mc only)

●● Panel operations cannot be performed during WPS
execution.

The message below will be displayed for
about 5 seconds.

●● When [WPS connection successful] is displayed,
this equipment is connected to the wireless LAN.

Memo

4

Check that [Automatic setup (WPS)]
is selected, and then press the .

5

Press the to select [WPS-PBC], and
then press OK .

●● If [Connection failed Timeout] is displayed, it
is possible that the wireless AP of the connection
destination could not be found within the time limit.
Select [Yes] again in step 6 within 2 minutes of
starting WPS push button for wireless AP.

●● If [Overlap] is displayed, WPS-push button is being
executed on 2 or more wireless AP. Please wait for a
short time and then retry.

Setting the IP address:

1
6

Press the
press OK .

to select [Yes], and then

Memo

●● Start the WPS push button for wireless AP after clicking
[Yes] in the confirmation screen. Alternatively, if WPS
push button for wireless AP is started first, start the
WPS push button on this equipment.
●● If [No] is selected, the screen returns to that from
step 5.
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Press the <SETTING> key on the
operator panel.

Faxing from a Computer (For Windows)

2

3

Press the
press OK .

to select [Easy Setup], and

Enter the administrator password.

4

Press the to select [Network
Setting], and then press the .

5

If setting the IP address manually, check
that [Manual] is selected, and press OK .

a

Press , , , to select the
character you want, and then
press OK .
If obtaining the IP address automatically, press
to select [Auto], and press OK . Proceed to
the
step 10.

6

Enter the IP address using the ten-key
pad, and press OK .

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

To move to the next box, press the

b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
OK .

7

Enter the subnet mask using the ten-key
pad, and press OK .
To move to the next box, press the

to select [Enter]

8

.

Enter the default gateway address using
the ten-key pad, and press OK .
To move to the next box, press the

9

.

.

Enter the DNS server and WINS server if
needed.
If it is not necessary to connect the DNS server
or WINS server to the network, press OK until the
pop-up message showing setting completion is
displayed.
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The factory default password is “aaaaaa”.

3

Faxing from a Computer (For Windows)

10 When the setup menu screen is
displayed, press
setup.

3

2

to complete the

Click [Run Setup.exe] after [AutoPlay]
is displayed.
If the [User Account Control] dialog box is
displayed, click [Yes].

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
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3

Select the language.

4

Select the device of your machine, and
then click [Next].

5

Read the license agreement and then
click [I Agree].

6

Read the “Environmental advice for
Users” and click [Next].

7

Click the Install button on the [FAX
driver] row.

11 For the confirmation message, check
that [Yes] is selected and press

OK

.

◆◆Print the Network Information to check that
the IP address and other network information
are set properly.

1

Press the <SETTING> key on the
operator panel.

2

Check that [Reports] is selected and
press OK .

3

Press the
press OK .

4

Press the to select [Network
Information] and press OK .

5

For the confirmation message, check
that [Yes] is selected and press OK .

to select [System] and

The Network Information is printed.

Step 2 Installing a Fax Driver
Note

●● To complete this procedure, you must be logged in as an
administrator.

1

Check that your machine and the
computer are turned on and connected,
and then insert the “Software DVD-ROM”
into the computer.
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8

On the [Pre-Installation Check] dialog
box, click [Next].

11 If the [Windows Security] dialog box
is displayed, click [Install this driver
software anyway].

12 Click the [Finish] button.

3
Click the [Easy Installation
(Network)] button.
The device search starts.

-- If the machine is detected, it is
automatically installed. Proceed to step
12.

13 Click [Exit] on the [Setup] window.
14 Click [Start] > [Devices and Printers].

-- If the machine is not detected, the
[Review your installation settings.]
screen is displayed. Proceed to step 10.

15 Check that the OKI MC562(FAX) icon is
displayed.

10 Click [Restart search] to restart the

If a printer driver for the machine is already
installed, the OKI MC562 icon may represent
these drivers. In this case, right-click the OKI
MC562 icon and select one of the menu items,
and then check that the fax driver is displayed in
the submenu.

device search.

16 Remove the “Software DVD-ROM” from
the computer.

The installation is complete.

After the machine is displayed, select the machine
and click [Next].

Memo

●● If the machine is not displayed by clicking [Restart
search], select [Printer name/IP Address] and
enter the IP address assigned to your machine, and
then click [Next].

- 47 -

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
MC562w, MC562dw, ES5462 MFP, ES5462dw MFP, MPS2731mc only)

9

Faxing from a Computer (For Windows)

6

 For USB Connection
Follow the procedure below to connect a USB
cable and install a fax driver on your computer.

Click [Run Setup.exe] after [AutoPlay]
is displayed.
If the [User Account Control] dialog box is
displayed, click [Yes].

Note

●● You must be logged in as an administrator to complete
this procedure.
Memo

3

●● You can skip this procedure if the fax driver is already
installed on your computer.

1

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
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7

Select the language.

8

Select the device of your machine, and
then click [Next].

9

Read the license agreement and then
click [I Agree].

Prepare a USB cable.
A USB cable is not supplied with your machine.
Prepare a USB 2.0 cable separately.

Memo

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 HiSpeed connection.

2

Hold down the power switch for
approximately one second to turn off the
power.

10 Read the “Environmental advice for
Users” and click [Next].

3

Plug one end of the USB cable into the
USB interface connector on the back of
the machine.

11 Click the Install button on the [FAX
driver] row.

4

Turn on the computer.

5

Insert “Software DVD-ROM” into the
computer.
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12 On the [Pre-Installation Check] dialog
box, click [Next].

15 When the instruction to connect the

machine to the computer and turn on
the machine is displayed, plug the other
end of the USB cable into the computer’s
USB interface connector and hold down
the power switch for approximately one
second to turn on the power.

3
Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
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13 Click [Easy Installation (Local)]
button.

14 If the [Windows Security] dialog box
is displayed, click [Install this driver
software anyway].

Note

●● Do not plug the USB cable into the network interface
connection. Doing so may damage your machine.

16 Click the [Finish] button.
17 Click [Exit] on the [Setup] window.
18 Click [Start] > [Devices and Printers].
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19 Check that the OKI MC562(FAX) icon is

Procedure for Fax from a
Computer

displayed.

If a printer driver for the machine is already
installed, the OKI MC562 icon may represent
these drivers. In this case, right-click the OKI
MC562 icon and select one of the menu items,
and then check that the fax driver is displayed in
the submenu.

3

20 Remove “Software DVD-ROM” from the
computer.

The installation is complete.

This section explains how to send fax data from
your computer.
You need to install the fax driver for your
machine on the computer before using the Fax
from Computer function.
Memo

Faxing (For MC342dn, MC342dw, MC362dn, MC362w, MC562dn,
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●● This section uses NotePad as example. The menu items
and procedure may differ according to the application and
the version of the fax driver you are using.
●● For additional information on the setting items on the fax
driver, refer to the driver’s help.

1

Open the file you want to fax.

2

From the [File] menu, select [Print].

3

From [Select Printer], select [OKI
MC562 (FAX)] and then click [Print].
The [Settings] dialog box is displayed.

4

On the [Recipient] tab, enter the
destination name in [Name] on the
[Specifying numbers] sheet.

5

Enter the destination fax number in
[FAX number].

6

Click [Add<-].

7

Repeat steps 4 to 6 to specify all the
destinations.

8

Click the [Sender] tab, and enter the
[Sender’s name] and the [Sender’s
number].

9

Click [OK] to start transmitting.
Memo

●● When you want to cancel a job while the data is
being transmitted to the machine, double-click the
printer icon in the toolbar, select the job to cancel,
and then select [Cancel] from the [Document]
menu.
Reference

●● Once the data is stored in the machine, you cannot cancel
the job from your computer. For details on how to cancel a
fax job stored in the machine memory, refer to the User’s
Guide > “Faxing - MC342dn, MC342dw, MC362dn, MC362w,
MC562dn, MC562w, MC562dw, ES5462 MFP, ES5462dw MFP
and MPS2731mc only” > “Sending a fax from the MFP” >
“Advanced operation” > “Fax job view/cancel”.
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4 Scanning
This chapter explains the initial setup and basic procedure for the Scan to E-mail, Scan to Shared
Folder and Scan to Computer functions.
Your machine supports the following scan functions.
Function
“Scanning to E-mail”
“Scanning to Shared
Folder”
Scanning to USB
Memory
“Scanning to Computer”

Scans documents and sends the scanned images as an attached file of an E-mail to the
specified E-mail address on the network.
Scans documents and saves the scanned images to the “shared folder” of a computer
on the network.
Scans documents and saves the scanned images directly to a USB memory.
For the procedure for the function, refer to the User’s Guide > “Scanning” > “Scan to
USB Memory”.
Scans documents to the computer via network or USB and manipulates the scanned
images as necessary by operating on the operator panel.
Scans documents to the computer via network or USB and manipulates the scanned
images as necessary by operating on the computer.
For the initial setup for the function, refer to the User’s Guide > “Scanning” >
“Installing Scanner Drivers (TWAIN/WIA/ICA Driver)”.
For the procedure for the function, refer to the User’s Guide > “Scanning” > “Remote
Scan”.

●●
Scanning to E-mail
This section explains the initial setup and basic procedure for the Scan to E-mail function.
This function enables you to scan documents and send the scanned images as an attached file of an
E-mail to the specified E-mail address on the network.
Be sure to finish the initial setup before using this function.

Initial Setup for Scan to
E-mail

Step 1 Configuring the Network
Settings of Your Machine
Connect your machine to a network with an Ethernet
cable or Wireless LAN connection (MC342dw,
MC362w, MC562w, MC562dw, ES5462dw MFP,
MPS2731mc only), and then configure the machine’s
IP address and other network information from the
operator panel. You can set the IP address either
manually or automatically.

This section explains how to configure the initial
setup for the Scan to E-mail function. Follow the
2 steps below:
●● “Step 1 Configuring the Network Settings of
Your Machine” P.51
●● “Step 2 Configuring the E-mail Settings of
Your Machine” P.56

If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or machine.

Note

●● You need to complete the network setting of the computer
before this procedure.
Memo

●● You can skip step 1 if the IP address is already set on your
machine.

If your network administrator or internet
service provider specifies a unique IP address
for the computer and your machine, set the IP
addresses manually.
Note

●● When setting an IP address manually, ask the network
administrator or your internet service provider which IP
address to use. If the IP address is set incorrectly, the
network may go down or Internet access may be disabled.
●● Conform the IP version of the machine to that of your
computer.
●● Set [TCP/IP] setting to [Enable] on your machine. (By
factory default, it is set to [Enable].)
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Scanning

Scanning from Remote
Computer

Overview

Scanning to E-mail
Memo

●● If configuring a small network consisting of only your
machine and a computer, set IP addresses as shown
below (according to RFC1918).

3

Plug one end of the Ethernet cable into
the network interface connection on the
back of the machine.

4

Plug the other end of the Ethernet cable
into the hub.

5

Hold down the power switch for
approximately one second to turn on the
power.

For the computer
IP address :

192.168.0.1~254

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

For the machine

4

IP Address Set :

Manual

IPv4 Address :

192.168.0.1~254
(select a different value
from the computer)

Subnet Mask :

255.255.255.0

Gateway Address :

0.0.0.0

Network Scale :

Small

Scanning

●● To set [Network Scale], press the <SETTING> key
and then select [Admin Setup] > [Network Menu] >
[Network Setup] > [Network Scale].

 Connecting using wired LAN
1

Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

2

Hold down the power switch for
approximately one second to turn off the
power.
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 Connecting using wireless LAN
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only)

6

Press the
press OK .

to select [Yes], and then

Use the WPS (push button) function to set the
wireless LAN. For details on other methods
for setting the wireless LAN, refer to the
Configuration Guide.

1
2

Press the <SETTING> key on the operator
panel.

Memo

●● Start the WPS push button for wireless AP after clicking
[Yes] in the confirmation screen. Alternatively, if WPS
push button for wireless AP is started first, start the
WPS push button on this equipment.

Press the to select [Wireless Setting],
and then press the .

●● If [No] is selected, the screen returns to that from
step 5.

7

Log in by entering administrator password
of the device.

Use , , ,
key to select letter and then
press OK .
Default administrator password is “aaaaaa”.

Note

●● Panel operations cannot be performed during WPS
execution.
●● When [WPS connection successful] is displayed,
this equipment is connected to the wireless LAN.

The message below will be displayed for
about 5 seconds.

Memo

4

Check that [Automatic setup (WPS)]
is selected, and then press the .

5

Press the to select [WPS-PBC], and
then press OK .

●● If [Connection failed Timeout] is displayed, it
is possible that the wireless AP of the connection
destination could not be found within the time limit.
Select [Yes] again in step 6 within 2 minutes of
starting WPS push button for wireless AP.

●● If [Overlap] is displayed, WPS-push button is being
executed on 2 or more wireless AP. Please wait for a
short time and then retry.
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3

If [Yes] is selected in step 6, [Running
pushbutton method...] is displayed in
the screen.

4

Scanning to E-mail

 Setting the IP address
1

4

Press the <SETTING> key on the
operator panel.

2

Press the
press OK .

3

Enter the administrator password.

to select [Easy Setup], and

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

to select [Enter]

OK

Press the to select [Network
Setting], and then press the .

5

If setting the IP address manually, check
that [Manual] is selected, and press OK .

Scanning

4

If obtaining the IP address automatically, press
the
to select [Auto], and press OK . Proceed to
step 10.

The factory default password is “aaaaaa”.

a

b

Press , , , to select the
character you want, and then
press OK .

6

Enter the IP address using the ten-key
pad, and press OK .

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.
To move to the next box, press the

7

Enter the subnet mask using the ten-key
pad, and press OK .
To move to the next box, press the

8

.

Enter the default gateway address using
the ten-key pad, and press OK .
To move to the next box, press the
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9

Enter the DNS server and WINS server if
needed.
If it is not necessary to connect the DNS server
or WINS server to the network, press OK until the
pop-up message showing setting completion is
displayed.

◆◆Print the Network Information to check that
the IP address and other network information
are properly set.

1

Press the <SETTING> key on the
operator panel.

10 When the setup menu screen is
displayed, press
setup.

to complete the

4
that [Yes] is selected and press

OK

2

Check that [Reports] is selected and
press OK .

3

Press the
press OK .

4

Press the to select [Network
Information] and press OK .

5

For the confirmation message, check
that [Yes] is selected and press OK .

.

to select [System] and

The Network Information is printed.
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11 For the confirmation message, check
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Step 2 Configuring the E-mail Settings of Your Machine
To configure the E-mail Settings of your machine, follow the 3 sub steps below:
●● “Step 2-1 Checking the E-mail Settings of the Computer” P.56
●● “Step 2-2 Setting the E-mail Address for Your Machine” P.57
●● “Step 2-3 Configuring Your Machine’s E-mail Settings” P.57
Check the values for each item in the Setup Information Form through the above steps.

 Setup Information Form
User Value

4

No.
B-1

Item

Scanning

B-2

E-mail address for
your machine
SMTP server address

B-3

POP3 server address

B-4

Authentication
method
SMTP user ID
SMTP password
POP user ID
POP password
Name of the E-mail
destination

B-5
B-6
B-7
B-8
B-9

Outline Introduction

Example

The E-mail address used when
sending E-mails from the machine
The address of the server used
when sending e-mails
The address of the server used
when receiving e-mails
Sending mail server authentication

mc362@test.
com
smtp.test.com

3

Note

●● If a network administrator specifies values such as mail
server account, password and E-mail address for your
machine, enter them in the Setup Information Form.
Memo

●● The procedure below uses Windows Live Mail on Windows
7. If you are using different mail software, refer to the
manual for the E-mail software.

1

Click [Start] and select [Windows Live
Mail].

2

Select the [Tools] menu > [Accounts].
If the menu bar is not displayed, click the
[Menus] icon and then select [Show menu
bar].
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(Up to 80 characters)

pop3.test.com
SMTP

Sending mail server account name
Sending mail server password
Receiving mail server account name
Receiving mail server password
The name of the recipient to whom
you are sending a scan-to-mail from
the machine
B-10 E-mail address of the The E-mail address of the recipient
E-mail destination
to whom you are sending a scan-tomail from the machine

 Step 2-1 Checking the E-mail
Settings of the Computer

*You can look at the following pages
and make notes on the details you
have checked or the settings you
have configured.

OKIMC562
okimc562
user
okimc562
User

user@test.com

Select the mail account and then click
[Properties].

Scanning to E-mail

4

On the [General] tab, enter the
contents of [Name] and [E-mail
address] in B-9 and B-10 of the Setup
Information Form.

7

B-9

Check the login information on the
[Outgoing Mail Server] dialog box.

-- If [Use same settings as my incoming
mail server] is selected, enter the same
values as B-7 and B-8 on B-5 and B-6.

B-10

-- If [Log on using] is selected, note
the content of [Account name] and
[Password] in B-5 and B-6, respectively.

Click the [Servers] tab, and then
note each setting in the corresponding
columns of the Setup Information Form.

B-3
B-2
B-7
B-8

When sending data scanned from the
machine by an E-mail, the E-mail address for
the machine is necessary. According to the
following procedure, set the E-mail address for
the machine and enter it in B-1 of the Setup
Information Form.
●● If the E-mail address for your machine is
specified by the network administrator, enter
the E-mail address in B-1.
●● If you are using an internet service provider,
obtain an E-mail address for your machine
from the provider and then enter the E-mail
address in B-1.

-- If there is a check in the [My server
requires authentication] checkbox,
enter “SMTP” into B-4 and follow
procedure 6.
-- If there is no check in the [My server
requires authentication] checkbox,
enter [POP or not yet authenticated]
in B-4. At this point the confirmation of
E-mail settings is complete.
Note

●● If using an internet service provider, enter [POP].

6

Click [Settings].

●● If the E-mail address for your machine is
neither specified nor obtained, determine the
E-mail address according to the value you
entered in B-4 (authentication method):
-- If B-4 is “SMTP”, determine an E-mail
address and enter it in B-1.
-- If B-4 is “POP”, enter the same E-mail
address as B-10 in B-1.
Note

●● If you want your machine to receive E-mail, you must
obtain an E-mail address for your machine from a network
administrator or your internet service provider.

 Step 2-3 Configuring Your
Machine’s E-mail Settings
Set up your machine’s E-mail settings using the
information in the Setup Information Form.
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5

 Step 2-2 Setting the E-mail
Address for Your Machine

4

Scanning to E-mail

1

4

2

Press the <SETTING> key on the
operator panel.

Press the
press OK .

c

to select [Easy Setup] and

Scanning

3

Enter the administrator password.

and
.

to select [Enter]

OK

4

Press the to select [E-mail Setting]
and then press the .

5

Press the and then enter the
information in B-2.

6

Select [Enter] and then press

7

Press the and then enter the
information in B-1.

8

Select [Enter] and then press

9

Press the and then select a protocol
for receiving E-mail for the machine, and
then press OK .

The factory default password is “aaaaaa”.

a

Press the
and press

Press , , , to select the
character you want, and then
press OK .

OK

.

OK

.

-- If you want your machine to receive
E-mail from the POP3 server, select
[POP3]. Proceed to step 10.
-- If you want your machine to receive
E-mail without using a mail server, select
[SMTP]. Proceed to step 12.
-- If you do not want your machine to
receive E-mail, select [Disable]. Proceed
to step 12.

10 Press the

and then enter the
information in B-3.

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

11 Select [Enter] and then press

OK

.

12 Press the

and then select an
authentication method based on the
information in B-4. Then, press OK .
-- If B-4 is “Do not authenticate”, select [No
Authentication]. Proceed to step 21.
-- If B-4 is “SMTP”, select [SMTP Auth].
Proceed to step 13.
-- If B-4 is “POP”, select [POP Before
SMTP]. Proceed to step 17.

13 Press the

and then enter the
information in B-5.

b

Repeat step a until all characters
required are entered.

14 Select [Enter] and then press
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15 Press the

and then enter the
information in B-6.

16 Select [Enter] and then press

Procedure of Scan to E-mail
OK

This section explains how to start Scan to
E-mail. The following procedure uses the direct
input method for specifying a destination.

.

Proceed to step 21.

You need to configure the initial network and
E-mail settings before using the Scan to E-mail
function.

17 Press the

and then enter the
information in B-7.

18 Select [Enter] and then press

OK

.

Memo

●● The following procedure uses the factory default settings.

19 Press the

and then enter the
information in B-8.

20 Select [Enter] and then press

1
OK

.

Press the <SCAN> key on the operator
panel.

21 When the setup menu screen is
.

Scanning

displayed, press

22 For the confirmation message, check
that [Yes] is selected and press

4

OK

2

.

Place your document in the ADF or on
the document glass as below:
●● ADF

The setup for Scan to E-mail is complete.

Load documents face up with the top edge of the
documents in first.

Adjust the document guides to the width of your
documents.
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7

●● Document Glass
Place a document face down and align its top
edge to the upper-left corner of the glass.

Enter a destination E-mail address up to
80 characters.

a

4

Press , , , to select the
character you want, and then
press OK .

Close the document glass cover gently.
The selected character is entered in the text
field.

Note

Scanning

●● Do not apply an excessive load to the document
glass.

If you have entered an incorrect value, press
the <CLEAR> key and then enter the correct
value.

Memo

●● The machine prioritizes the ADF when scanning
documents. Be sure not to place documents on the
ADF when you use the document glass.
Note

3

b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

to select [Enter]

OK

●● If Carriage Error <02> is displayed, press Power
OFF/ON.

8

If necessary, select [Cc] or [Bcc] and
repeat steps 6 and 7.

Check that [E-mail] is selected and then
press OK .

9

Press the

10 Press

MONO

to return to start screen.
or

COLOR

.

Reference

●● In addition to inputting the destination directly, you can
use the address book, group list, E-mail histories, LDAP
search, or One-Touch key pad to specify the destination.
For details, refer to the User’s Guide > “Scanning” >
“Scan to E-mail”.
●● To load a landscape document, refer to the User’s Guide >
“Operation” > “Loading document(s)”.

4

Check that [Add Destination] is
selected and then press OK .

5

Check that [To] is selected and then
press OK .

6

Press the to select [Direct Input] and
then press OK .
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●●
Scanning to Shared Folder
This section explains the initial setup and basic procedure for the Scan to Shared Folder function.
This function enables you to scan documents and save the scanned images to the “shared folder” of a
computer on the network.
Be sure to finish the initial setup before using this function.

Initial Setup for Scan to
Shared Folder

Memo

●● If configuring a small network consisting of only your
machine and a computer, set IP addresses as shown
below (according to RFC1918).

This section explains how to configure the initial
setup for the Scan to Shared Folder function.
Follow the 2 steps below:

For the computer
IP address :

●● “Step 1 Configuring the Network Settings of
Your Machine” P.61

192.168.0.1~254

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

●● “Step 2 Setting Up Your Computer and
Machine for Scan to Shared Folder” P.65

IP Address Set :

Manual

IPv4 Address :

192.168.0.1~254
(select a different value
from the computer)

Subnet Mask :

255.255.255.0

Gateway Address :

0.0.0.0

Network Scale :

Small

Note

●● You need to configure the network setting of the computer
before this procedure.
Memo

●● You can skip step 1 if the IP address is already set on your
machine.

Step 1 Configuring the Network
Settings of Your Machine

●● To set [Network Scale], press the <SETTING> key
and then select [Admin Setup] > [Network Menu] >
[Network Setup] > [Network Scale].

 Connecting using wired LAN

Connect your machine to a network with an
Ethernet cable or Wireless LAN connection
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only), and then
configure the machine’s IP address and other
network information from the operator panel.
You can set the IP address either manually or
automatically.

1

Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or machine.
If your network administrator or internet
service provider specifies a unique IP address
for the computer and your machine, set the IP
addresses manually.

2

Note

●● When setting an IP address manually, ask the network
administrator or your internet service provider which IP
address to use. If the IP address is set incorrectly, the
network may go down or Internet access may be disabled.
●● Conform the IP version of the machine to that of your
computer.
●● Set [TCP/IP] setting to [Enable] on your machine. (By
factory default, it is set to [Enable].)
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Hold down the power switch for
approximately one second to turn off the
power.
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For the machine

4
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3

 Connecting using wireless LAN
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only)

Plug one end of the Ethernet cable into
the network interface connection on the
back of the machine.

Use the WPS (push button) function to set the
wireless LAN. For details on other methods
for setting the wireless LAN, refer to the
Configuration Guide.

1

Press the <SETTING> key on the operator
panel.

2

Press the to select [Wireless Setting],
and then press the .

3

Log in by entering administrator password
of the device.

4
Scanning

4

Plug the other end of the Ethernet cable
into the hub.

Use , , ,
key to select letter and then
press OK .
Default administrator password is “aaaaaa”.

The message below will be displayed for
about 5 seconds.

5

Hold down the power switch for
approximately one second to turn on the
power.

4

Check that [Automatic setup (WPS)]
is selected, and then press the .

5

Press the to select [WPS-PBC], and
then press OK .
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6

Press the
press OK .

 Setting the IP address

to select [Yes], and then

1

Press the <SETTING> key on the
operator panel.

2

Press the
press OK .

3

Enter the administrator password.

Memo

●● Start the WPS push button for wireless AP after clicking
[Yes] in the confirmation screen. Alternatively, if WPS
push button for wireless AP is started first, start the
WPS push button on this equipment.
●● If [No] is selected, the screen returns to that from
step 5.

7

4
Scanning

If [Yes] is selected in step 6, [Running
pushbutton method...] is displayed in
the screen.

to select [Easy Setup], and

The factory default password is “aaaaaa”.

Note

●● Panel operations cannot be performed during WPS
execution.

a

●● When [WPS connection successful] is displayed,
this equipment is connected to the wireless LAN.

Press , , , to select the
character you want, and then
press OK .

Memo

●● If [Connection failed Timeout] is displayed, it
is possible that the wireless AP of the connection
destination could not be found within the time limit.
Select [Yes] again in step 6 within 2 minutes of
starting WPS push button for wireless AP.

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

●● If [Overlap] is displayed, WPS-push button is being
executed on 2 or more wireless AP. Please wait for a
short time and then retry.
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4

4

5

b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
OK .

9

Enter the DNS server and WINS server if
needed.
If it is not necessary to connect the DNS server
or WINS server to the network, press OK until the
pop-up message showing setting completion is
displayed.

to select [Enter]

Press the to select [Network
Setting], and then press the .

10 When the setup menu screen is
displayed, press
setup.

Scanning

If setting the IP address manually, check
that [Manual] is selected, and press OK .

to complete the

11 For the confirmation message, check
that [Yes] is selected and press

OK

.

◆◆Print the Network Information to check that
the IP address and other network information
are properly set.
If obtaining the IP address automatically, press
the
to select [Auto], and press OK . Proceed to
step 10.

6

2

Check that [Reports] is selected and
press OK .

3

Press the
press OK .

4

Press the to select [Network
Information] and press OK .

.

5

For the confirmation message, check
that [Yes] is selected and press OK .

Enter the subnet mask using the ten-key
pad, and press OK .
To move to the next box, press the

8

Press the <SETTING> key on the
operator panel.

Enter the IP address using the ten-key
pad, and press OK .

To move to the next box, press the

7

1

.

Enter the default gateway address using
the ten-key pad, and press OK .
To move to the next box, press the

.
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to select [System] and

The Network Information is printed.
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Step 2 Setting Up Your Computer and Machine for Scan to Shared Folder
To setup your computer and machine for Scan to Shared Folder, follow the 4 sub steps below:
●● “Step 2-1 Checking the Name of the Computer” P.65
●● “Step 2-2 Determining the Names of the Items Required for Scan to Shared Folder” P.66
●● “Step 2-3 Configuring the Computer for Scan to Shared Folder” P.67
●● “Step 2-4 Creating a Profile for Scan to Shared Folder” P.74
Check the values for each item in the Setup Information Form through the above steps.

 Setup Information Form
User Value
No.

C-2

C-3

C-4
C-5

C-6

Outline Introduction

Example

Name of the
destination computer
User name to log
into the destination
computer
Password to log
into the destination
computer
Profile name to
register the settings
Shared folder name
on the destination
computer
File name of the
scanned data

The name of the computer to which
you are forwarding scanned data
User name to log in to the computer
to which you are forwarding scanned
data
Password to log in to the computer
to which you are forwarding scanned
data
Name when registering a profile on
the machine
Folder name of the computer to
which you are forwarding scanned
data
Scanned data file name

*You can look at the following pages
and make notes on the details you
have checked or the settings you
have configured.

PC1
mc562

(Up to 32 characters)

mc562

(Up to 32 characters)

Sales

(Up to 16 characters)

SalesDev

(Up to 64 characters)

ScanData

(Up to 64 characters)

Note

●● Before starting the setup, obtain permission from the network administrator to create a shared folder on the computer by
following the procedure below.
Memo

●● The CIFS protocol is used in this procedure.

 Step 2-1 Checking the Name of
the Computer

3

Select [See the name of this
computer] under [System].

Check the name of the computer following the
procedure below, and fill in C-1 of the Setup
Information Form.

4

Enter the name in [Computer name] in
C-1 of the Setup Information Form.

For Windows 8, Windows Server
2012, Windows 7, Windows Server
2008 R2, Windows Server 2008 and
Windows Vista

1
2

Click [Start] and select [Control
Panel].

C-1

Select [System and Security].
For Windows Server 2008 and Windows Vista,
select [System and Maintenance].

5
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Close the window.

4
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C-1

Item

Scanning to Shared Folder

 Step 2-2 Determining the Names
of the Items Required for Scan to
Shared Folder

For Windows Server 2003 and
Windows XP

1

Click [start] > [Control Panel] >
[Performance and Maintenance] >
[System].

Determine the names of the following items and
fill in C-2 to C-6 on the Setup Information Form.
●● User name to log into the destination computer (C-2)

For Windows Server 2003, click [Start] >
[Operator panel] > [System].

4

Note

2

Select the [Computer Name] tab and
then click [Change].

3

Enter the name in [Computer Name] in
C-1 of the Setup Information Form.

4

Click [Cancel] to close the window.

●● Password to log into the destination computer
(C-3)
●● Profile name to register the settings on your
machine (C-4)

Scanning

For Mac OS X

1

●● If the username is managed on the domain,
enter “Username@Domainname” in C-2. To check
the domain name, click on [Change] within the
[Computer Name] tab in the [System Properties]
dialog box.

●● Shared folder name on the destination
computer (C-5)

From the Apple menu, select [System
Preferences].

●● File name of the scanned data (C-6)
“#n” or #d” can be specified for the file name.

2

Click [Sharing].

3

Enter the name in [Computer Name] in
C-1 of the Setup Information Form.

-- When specifying “#n”: 5-digit serial
number between 00000 to 99999
-- When specifying “#d”: Date and time
when a file is created. 12 digits of
yymmddhhmmss.
yy:

Year created (the last 2 digits of the
Christian Era)
mm: Month created (01 to 12)
dd: Date created (01 to 31)
hh: Hours created (00 to 23)
mm: Minute created (00 to 59)
ss:
Second created (00 to 59)

C-1

* A date and time when a file is created are values of the
timer of the machine.

Example of file name specification (when the file
format is PDF)
Memo

●● If the computer name is over 16 characters, for
Mac OS X 10.4.11 enter the first 15 characters in
C-1. For Mac OS X 10.5-10.7, select the network
service you are using from [System Preferences] >
[Network], and click [Advanced]. Click the [WINS]
tab, and enter the name in [NetBIOS Name] into
C-1.

4

Close [Sharing].

-- When specifying “Data#n”: Saved as
file names such as “Data00000.pdf” and
“Data00001.pdf”,etc.
-- When specifying “File#d”: saved as file
names “File090715185045.pdf”, etc.
-- When specifying “Scan”: “Scan.pdf” is
created first, and then, data is saved with
the name of ”Scan#d.pdf”.
For “#d”, refer to the above.
-- When nothing is specified: “Image.pdf” is
created first and then, data is saved with
the name of “Image#d.pdf”.
For “#d”, refer to the above.
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8

 Step 2-3 Configuring the
Computer for Scan to Shared
Folder
With the Setup Information Form, create an
account and shared folder for the machine in the
computer.

Enter the information in C-3 in [New
password] and [Confirm new
password], and then click [Create
password].

Memo

●● If the computer is in a domain, the procedure for adding a
user account may differ from the procedure below. Refer
to the Microsoft Windows manual.

For Windows 8, Windows Server
2012, Windows 7, Windows Server
2008 R2, Windows 2008 and
Windows Vista

4

Click [Start] > [Control Panel].

2

Select [Add or remove user
accounts].

9

3

Select [Create a new account].

10 Create a new folder on the computer

4

Enter the information in C-2 in the text
box.

Close the Control Panel.
with the name entered in C-5.
Memo

●● It is recommended that the folder be created in the
local drive (C drive or D drive), not on the desktop,
[Documents], or network drive.

11 Right-click the folder created in step 10
and select [Properties].

12 Select the [Sharing] tab and then click
[Share].

5

Ensure that [Standard user] is
selected, and then click [Create
Account].

6

Click the icon of the user account
created in step 5.

7

Select [Create a password].
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13 Select the user account created in step 5
from the drop down box, and then click
[Add].

4

18 Click [Add].

19 Enter the value in C-2 in the entry field
and then click [OK].

14 Check that the user added in step 13 is

Scanning

displayed and then click [Share].

20 Select the user added in step 13 and

select the [Allow] checkbox for [Full
Control], and then click [OK].

After the [Network discovery and file sharing]
dialog box is displayed, click [No, make the
network that I am connected to a private
network].

15 Click [Done].
16 Click [Advanced Sharing] on the
[Sharing] tab.

17 Click [Permissions].

21 Click [OK].
22 Click [Close].
Proceed to “Step 2-4 Creating a Profile for Scan
to Shared Folder” P.74.

For Windows XP

For Windows Vista/Windows Server 2008,
proceed to step 20.

1

Click [start] > [Control Panel].

2

Double-click [User Accounts].

3

Select [Create a new account].
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4

11 Right-click the folder created in step

Enter the value of C-2 in the text box
and click [Next].

10, and then select [Sharing and
Security].

12 Click [If you understand the security

risks but want to share files without
running the wizard, click here.].

5

Select [Limited] and click [Create
Account].

4

6

Click the icon of the user account
created in step 5.

7

Select [Create a password].

8

Enter the value of C-3 in [Type a
new password] and [Type the new
password again to confirm], and then
click [Create Password].

13 Select [Just enable file sharing] in

Windows Firewall, and then click [OK].

9

Close the Control Panel.

10 Create a new folder on the computer
with the name entered in C-5.
Memo

●● It is recommended that the folder be created in the
local drive (C drive or D drive), not on the desktop,
[My Documents], or network drive.
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If the screen below is displayed, select [Share
this folder] and click [Permissions]. Proceed to
step 15.
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14 Select the [Share this folder on the

network] and [Allow network users
to change my files] checkbox, and
then click [OK].

17 Select the [Allow] checkbox for [Full
Control], and then click [OK].

Proceed to “Step 2-4 Creating a Profile for Scan
to Shared Folder” P.74.

4
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Proceed to “Step 2-4 Creating a Profile for Scan
to Shared Folder” P.74.

15 Click [Add].

For Windows Server 2003
Memo

●● The items here may differ depending on the edition you
are using.

1

Click [Start] > [Administrative Tools] >
[Computer Management].

2

In the right window, double-click
[System Tools] > [Local Users and
Groups], and then right-click [Users]
and select [New User].

3

Enter the value of C-2 in [User name]
and the value of C-3 in [Password] and
[Confirm password].

16 Enter the value in C-2 in the entry field
and click [OK].

- 70 -

Scanning to Shared Folder

4

12 Enter the value in C-2 in the entry field

Select [User can not change
password] and [Password never
expires], and then click [Create].

and click [OK].

Memo

●● If [User must change password at next logon]
is selected, deselect so that you can select [User
can not change password] and [Password never
expires].

5

Click [Close].

6

Double-click [User] and check that the
user created in step 4 is displayed.

7

Close the window.

8

Create a new folder on the computer
with the name entered in C-5.

13 Select the [Allow] checkbox for [Full
Control], and then click [OK].

4
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Memo

●● It is recommended that the folder be created in the
local drive (C drive or D drive), not on the desktop,
[My Documents], or network drive.

9

Right-click the folder created in step 8
and then select [Sharing].

14 Ensure that the icon of the shared folder
created in step 8 changes into the icon
with a hand, and then close the window.
Proceed to “Step 2-4 Creating a Profile for Scan
to Shared Folder” P.74.

10 Select [Share this folder] and then
click [Permissions].

For Mac OS X 10.5 to 10.7

1

From the Apple menu, select [System
Preferences].

2

Click [Users & Groups] (for Mac OS X
10.5 and 10.6: [Accounts]).

3

Click [Click the lock to make
changes.] at the bottom left of the
screen and enter the administrator’s
password. Then, click [Unlock] (for Mac
OS X 10.5 and 10.6: [OK]).

4

Click [+].

11 Click [Add].
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4

5

Select [Standard] from [New
Account].

6

Enter the value of C-2 in [Full Name].

13 Select the checkbox for [File Sharing].

For Mac OS X 10.5, enter the value of C-2 in
[Name].

7

Scanning

8

14 Click [+] under [Shared Folders].

Enter the value in C-3 in both
[Password] and [Verify].

15 Select the folder created in step 10 and
click [Add].

Click [Create User] (for Mac OS X 10.5
and 10.6: [Create Account]).

16 Select the folder added in step 15 and

Memo

click [+] under [Users].

●● After the dialog box for auto login, disable the auto
login.

9

Check that an account is added to
[Other Users] (for Mac OS X 10.5 and
10.6: [Other Accounts]) with the name
of C-2, and close [Users & Groups] (for
Mac OS X 10.5 and 10.6: [Accounts]) .

17 Select the account created in step 8 and
click [Select].

10 Create a new folder on the computer
with the name entered in C-5.

11 From the Apple menu, select [System
Preferences].

12 Click [Sharing].
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18 Click the triangle button at the right side
of the user added in step 17 and select
[Read & Write].

For Mac OS X 10.3.9 to 10.4.11
Memo

●● The following procedure uses Mac OS X 10.4.11 as an
example. The description may differ depending on the OS.

From the Apple menu, select [System
Preferences].

2

Click [Accounts].

3

Click [Click the lock to make
changes.] at the bottom left of the
screen and enter the administrator’s
password. Then, click [OK].

4

Click [+].

5

Enter the value of C-2 in [Name].

6

Enter the value in C-3 in both
[Password] and [Verify].

7

Click [Create Account].

4
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1

19 Click [Options].
20 Select the checkbox for [Share files

and folders using SMB (Windows)].
For Mac OS X 10.5, select the checkbox for
[Share files and folders using SMB].

21 Select the checkbox for the account
added in the step 16.

22 Enter the value of C-3 in [Password]
and click [OK].

Memo

23 Click [Done].

●● After the dialog box for auto login, disable the auto
login.

24 Close [Sharing].
Proceed to “Step 2-4 Creating a Profile for Scan
to Shared Folder” P.74.

- 73 -

Scanning to Shared Folder

8

Check that an account is added to
[Other Accounts] with the name of
C-2, and close [Accounts].

15 Enter the value in C-3 in [Password]
and click [OK].

16 Click [Done].
17 Close [Sharing].
Proceed to “Step 2-4 Creating a Profile for Scan
to Shared Folder” P.74.

4

 Step 2-4 Creating a Profile for
Scan to Shared Folder

Scanning

9

Create a new folder on the computer
with the name entered in C-5.

10 From the Apple menu, select [System
Preferences].

11 Click [Sharing].

Register the information on the Setup
Information Form on the machine as a profile. It
is necessary to specify the profile to send data
when you perform Scan to Shared Folder with
the computer.

1

Press the <SETTING> key on the
operator panel.

2

Press the
press OK .

3

Press the to select the profile number
you want to register and then press OK .

4

Check that [Register] is selected and
then press OK .

5

Check that [Profile Name] is selected
and then press the .

6

Enter the information in C-4.

12 Select the checkbox of [Windows
Sharing].

to select [Profile] and then

13 Click [Accounts...].
14 Select the checkbox for the account
created in the step 7.
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a

11 Enter the information in C-2.

Press , , , to select the
character you want, and then
press OK .

Note

●● If domain management is done, enter “C-2@domain
name”.
●● When carrying out domain management, if
you cannot connect even after entering “C-2@
Domainname”, delete “@Domainname”.
Access the machine’s website again, and set the
NetBIOS domain name in [Workgroup Name]
within [Admin Setup] > [Network] > [NBT/
NetBEUI].
*For the domain name, please check with the
network manager.

12 Select [Enter] and then press
13 Press the

-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

14 Enter the value of C-3.

.

to select [Password] and
then press .

15 Select [Enter] and then press
16 Press the

then press

OK

.

to select [File Name] and
.

17 Enter the information in C-6.
18 Select [Enter] and then press

OK

.

19 Configure other items if necessary.
b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

8

Enter the value of C-1 and C-5 as
“\\C- 1\C-5”.

The setup for Scan to Shared Folder is complete.

\\PC1\SalesDev

Note

●● If there is no DNS server on the network, you cannot
specify the computer by using the computer name
(C-1). In such a case, you can configure the settings
by using the computer’s IP address.

\\192.168.0.3\SalesDev

Memo

●● In order to enter the “\” sign while using a QWERTY
keyboard, press <CTRL> and then press <\>.

9

to register the settings.

to select [Enter]

Press the to select [Target URL] and
then press .

Example:

OK

OK

7

Example:

20 Press

Select [Enter] and then press

OK

.

10 Press the

to select [User Name] and
then press .
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-- The selected character is entered in the
text field.

OK

Scanning to Shared Folder
Note

Procedure for Scan to Shared
Folder

●● Do not apply an excessive load to the document
glass.

This section explains how to start Scan to
Shared Folder.
You need to configure the initial settings before
using the Scan to Shared Folder function.
Memo

●● The following procedure uses the factory default settings.

1

Press the <SCAN> key on the operator
panel.
Memo

4

●● The machine prioritizes the ADF when scanning
documents. Be sure not to place documents on the
ADF when you use the document glass.

Scanning

Note

●● If Carriage Error <02> is displayed, press Power
OFF/ON.

2

3

Press the to select [Shared Folder]
and then press OK .

4

Check that [Select Profile] is selected
and then press OK .

5

Press the
press OK .

to select a profile and then

6

Press

or

Place your document in the ADF or on
the document glass as below:
●● ADF
Load documents face up with the top edge of the
documents in first.

MONO

COLOR

.

Reference

Adjust the document guides to the width of your
documents.

●● To load a landscape document, refer to the User’s Guide >
“Operation” > “Loading document(s)”.

●● Document Glass
Place the document face down and align its top
edge to the upper-left corner of the glass.

Close the document glass cover gently.
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●●
Scanning to Computer
This section explains the initial setup and basic procedure for the Scan to Computer function.
This function enables you to scan documents to the computer via network or USB, and manipulate the
scanned images as necessary. You can start a scan job from the operator panel.
●● For Windows
When you press the
or
, the ActKey utility starts, and the scan job starts automatically using
the scanner driver. You can send the scanned document to a specified application, save it in a specified
folder, or send it by fax.
MONO

COLOR

For the WSD Scan connection, you can specify the application to start and where to send and save the
scanned document for each destination.
●● For Mac OS X
When you press the
or
, Image Capture starts, and the scan job starts automatically using
the ICA driver. You can select a folder and save the scanned documents in it.

4

The machine can be connected to USB interface or network, but only a computer can be recognized at
the same time.

Scanning

MONO

COLOR

Be sure to finish the initial setup before using this function.

Initial Setup for Scan to
Computer
This section explains how to configure the initial
setup for the Scan to Computer function.

Product Requirements
Your machine supports the following Windows
operating systems.
For Network/USB Connection:

Refer to the procedure for the OS you are using.

●● Windows 8/Windows 8 (64bit Version)

●● “For Windows” P.77

●● Windows Server 2012

●● “For Mac OS X” P.90

●● Windows 7/Windows 7 (64bit Version)

For Windows
 Overview
Connecting Methods
You can select one of the following connection
methods:

●● Windows Vista/Windows Vista (64bit Version)
●● Windows Server 2008 R2
●● Windows Server 2008/Windows Server 2008
(x64 Version)
●● Windows XP/Windows XP (x64 Version)
●● Windows Server 2003/Windows Server 2003
(x64 Version)

●● “For Network Connection” P.78

For WSD Scan Connection:

●● “For USB Connection” P.83

●● Windows 8/Windows 8 (64bit Version)

●● “For WSD Scan Connection” P.85

●● Windows Server 2012
●● Windows 7/Windows 7 (64bit Version)
●● Windows Vista/Windows Vista (64bit Version)
●● Windows Server 2008 R2
●● Windows Server 2008/Windows Server 2008
(x64 Version)
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 For Network Connection

Memo

●● If configuring a small network consisting of only your
machine and a computer, set IP addresses as shown
below (according to RFC1918).

To configure the Scan to Computer function
via the network connection, follow the 2 steps
below:

For the computer
IP address :

●● “Step 1 Configuring the Network Settings of
Your Machine” P.78
●● “Step 2 Installing Driver and Software” P.82
Note

255.255.255.0

Default gateway :

not used

DNS server :

not used

For the machine

●● You need to configure the network setting of the computer
before this procedure.

IP Address Set :

Manual

IPv4 Address :

192.168.0.1~254
(select a different value
from the computer)

Memo

4

192.168.0.1~254

Subnet mask :

●● You can skip step 1 if the IP address is already set on your
machine.
●● You can skip step 2 if the scanner driver and ActKey are
already installed on your computer.

Subnet Mask :

255.255.255.0

Gateway Address :

0.0.0.0

Network Scale :

Small

Scanning

●● To set [Network Scale], press the <SETTING> key
and then select [Admin Setup] > [Network Menu] >
[Network Setup] > [Network Scale].

Step 1 Configuring the Network
Settings of Your Machine
Connect your machine to a network with an
Ethernet cable or Wireless LAN connection
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only), and then
configure the machine’s IP address and other
network information from the operator panel.
You can set the IP address either manually or
automatically.

Connecting using wired LAN:

1

Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or machine.
If your network administrator or internet
service provider specifies a unique IP address
for the computer and your machine, set the IP
addresses manually.

2

Note

●● When setting an IP address manually, ask the network
administrator or your internet service provider which IP
address to use. If the IP address is set incorrectly, the
network may go down or Internet access may be disabled.
●● To configure the Scan to Computer function via the
network connection, follow these instructions.
--Conform the IP version of the machine to that of your
computer.
--Set [TCP/IP] setting to [Enable] on your machine.
(By factory default, it is set to [Enable].)
--Set [Network TWAIN] setting to [ON] on your
machine. (By factory default, it is set to [ON]. If
it has been disabled, enable it by referring to the
Configuration Guide > “Configuring the Scan to
Computer and Remote Scan” > “Using Functions for
Scan to Computer and Remote Scan” > “Enabling the
Network TWAIN Setting”.)
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Hold down the power switch for
approximately one second to turn off the
power.

Scanning to Computer

3

Plug one end of the Ethernet cable into
the network interface connection on the
back of the machine.

Connecting using wireless LAN
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only):
Use the WPS (push button) function to set the
wireless LAN. For details on other methods
for setting the wireless LAN, refer to the
Configuration Guide.

1

Press the <SETTING> key on the operator
panel.

2

Press the to select [Wireless Setting],
and then press the .

4
Plug the other end of the Ethernet cable
into the hub.

3

Log in by entering administrator password
of the device.

Use , , ,
key to select letter and then
press OK .
Default administrator password is “aaaaaa”.

The message below will be displayed for
about 5 seconds.

5

Hold down the power switch for
approximately one second to turn on the
power.

4

Check that [Automatic setup (WPS)]
is selected, and then press the .

5

Press the to select [WPS-PBC], and
then press OK .
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6

Press the
press OK .

to select [Yes], and then

Setting the IP address:

1

Press the <SETTING> key on the
operator panel.

2

Press the
press OK .

3

Enter the administrator password.

Memo

●● Start the WPS push button for wireless AP after clicking
[Yes] in the confirmation screen. Alternatively, if WPS
push button for wireless AP is started first, start the
WPS push button on this equipment.

4

●● If [No] is selected, the screen returns to that from
step 5.

7

Scanning

If [Yes] is selected in step 6, [Running
pushbutton method...] is displayed in
the screen.

to select [Easy Setup], and

The factory default password is “aaaaaa”.

Note

●● Panel operations cannot be performed during WPS
execution.

a

●● When [WPS connection successful] is displayed,
this equipment is connected to the wireless LAN.

Press , , , to select the
character you want, and then
press OK .

Memo

●● If [Connection failed Timeout] is displayed, it
is possible that the wireless AP of the connection
destination could not be found within the time limit.
Select [Yes] again in step 6 within 2 minutes of
starting WPS push button for wireless AP.

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

●● If [Overlap] is displayed, WPS-push button is being
executed on 2 or more wireless AP. Please wait for a
short time and then retry.
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4

5

b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
OK .

9

Enter the DNS server and WINS server if
needed.
If it is not necessary to connect the DNS server
or WINS server to the network, press OK until the
pop-up message showing setting completion is
displayed.

to select [Enter]

Press the to select [Network
Setting], and then press the .

10 When the setup menu screen is
displayed, press
setup.

4
11 For the confirmation message, check
that [Yes] is selected and press

OK

.

◆◆Print the Network Information to check that
the IP address and other network information
are properly set.
If obtaining the IP address automatically, press
the
to select [Auto], and press OK . Proceed to
step 10.

6

2

Check that [Reports] is selected and
press OK .

3

Press the
press OK .

4

Press the to select [Network
Information] and press OK .

.

5

For the confirmation message, check
that [Yes] is selected and press OK .

Enter the subnet mask using the ten-key
pad, and press OK .
To move to the next box, press the

8

Press the <SETTING> key on the
operator panel.

Enter the IP address using the ten-key
pad, and press OK .

To move to the next box, press the

7

1

.

Enter the default gateway address using
the ten-key pad, and press OK .
To move to the next box, press the

.
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to select [System] and

The Network Information is printed.
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If setting the IP address manually, check
that [Manual] is selected, and press OK .

to complete the

Scanning to Computer

7

Step 2 Installing Driver and Software
The following procedure installs a scanner driver
and ActKey at once.

Check that [Scanner driver] and
[ActKey] are selected, and then click
the Install bunch button.
Memo

1

Check that your machine and the
computer are turned on and connected,
and then insert the”Software DVD-ROM”
into the computer.

2

Click [Run Setup.exe] after [AutoPlay]
is displayed.

●● By default, [PCL driver], [Scanner driver], and
[ActKey] are selected. Deselect [PCL driver] if it is
unnecessary or has been installed on the computer
already.

If the [User Account Control] dialog box is
displayed, click [Yes].

4
Scanning

3

Select the language.

4

Select the device of your machine, and
then click [Next].

8

If the [Windows Security] dialog box
is displayed, click [Install this driver
software anyway].

9

Click the [Network] button.
The device search starts.

5

Read the license agreement and then
click [I Agree].

6

Read “Environmental advice for Users”
and click [Next].

-- If the machine is detected, it is
automatically installed. Proceed to step
11.
-- If the machine is not detected, the
[Review your installation settings.]
screen is displayed. Proceed to step 10.
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10 Click [Restart search] to restart the

13 Remove the “Software DVD-ROM” from

device search.

the computer.

The installation is complete.
Reference

●● When installing ActKey, Network Configuration is
also installed simultaneously. Network Configuration
automatically acquires the IP address of your machine
and network information (IP address, computer name,
port number) of the computer. If the IP address or other
settings of the machine or computer is changed, you
need to change the settings. For details, refer to the
Configuration Guide > “Configuring the Scan to Computer
and Remote Scan” > “Using Drivers and Software” >
“Using ActKey Software” > “Using Network Configuration”.

After the machine is displayed, select the machine
and click [Next].

 For USB Connection

Memo

●● You can skip this procedure if the scanner driver and
ActKey are already installed on your computer.

1

Prepare a USB cable.
A USB cable is not supplied with your machine.
Prepare a USB 2.0 cable separately.

Memo

●● If the machine is not displayed by clicking [Restart
search], select [Printer name/IP Address] and
enter the IP address assigned to your machine, and
then click [Next].

11 If the [Windows Security] dialog box

Memo

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 HiSpeed connection.

is displayed, click [Install this driver
software anyway].

12 Click the [Exit] button.

2
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Hold down the power switch for
approximately one second to turn off the
power.

4
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To configure the Scan to Computer function via
the USB connection, install a scanner driver and
ActKey on the computer.

Scanning to Computer

4
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3

Plug one end of the USB cable into the
USB interface connector on the back of
the machine.

10 Read the “Environmental advice for

4

Turn on the computer.

5

Insert “Software DVD-ROM” into the
computer.

6

Click [Run Setup.exe] after [AutoPlay]
is displayed.

Users” and click [Next].

11 Check that [Scanner driver] and

[ActKey] are selected, and then click
the Install bunch button.
Memo

●● By default, [PCL driver], [Scanner driver], and
[ActKey] are selected. Deselect [PCL driver] if it is
unnecessary or has been installed on the computer
already.

If the [User Account Control] dialog box is
displayed, click [Yes].

7

Select the language.

8

Select the device of your machine, and
then click [Next].

12 If the [Windows Security] dialog box
is displayed, click [Install this driver
software anyway].

9

Read the license agreement and then
click [I Agree].
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13 When the instruction to connect the

machine to the computer and turn on
the machine is displayed, plug the other
end of the USB cable into the computer’s
USB interface connector and hold down
the power switch for approximately one
second to turn on the power.

 For WSD Scan Connection
To configure the Scan to Computer via the WSD
Scan connection, follow the 2 steps below:
●● “Step 1 Configuring the Network Settings of
Your Machine” P.85
●● “Step 2 Installing Your Machine to the
Computer” P.89
Note

●● You need to configure the network setting of the computer
before this procedure.
Memo

●● You can skip the step 1 if the IP address is already set on
your machine.

Connect your machine to a network with an
Ethernet cable or Wireless LAN connection
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only), and then
configure the machine’s IP address and other
network information from the operator panel.
You can set the IP address either manually or
automatically.
If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or machine.
If your network administrator or internet
service provider specifies a unique IP address
for the computer and your machine, set the IP
addresses manually.
Note

●● When setting an IP address manually, ask the network
administrator or your internet service provider which
IP address to use. If the IP address is set wrong, the
network may go down or Internet access may be disabled.
●● To configure the Scan to Computer function via the WSD
Scan connection, follow these instructions.
--Conform the IP version of the machine to that of your
computer.
Note

--Set [TCP/IP] setting to [Enable] on your machine.
(By factory default, it is set to [Enable].)

●● Do not plug the USB cable into the network interface
connection. Doing so may damage your machine.

--Set [WSD Scan] setting to [Enable] on your
machine. (By factory default, it is [Enable]. If it
has been disabled, enable it by referring to the
Configuration Guide > “Configuring the Scan to
Computer and Remote Scan” > “Using Functions for
Scan to Computer and Remote Scan” > “Enabling the
WSD Scan”.)

14 Click the [Exit] button.
15 Remove “Software DVD-ROM” from the
computer.

The installation is complete.
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Step 1 Configuring the Network
Settings of Your Machine

Scanning to Computer
Memo

●● If configuring a small network consisting of only your
machine and a computer, set IP addresses as shown
below (according to RFC1918).

3

Plug one end of the Ethernet cable into
the network interface connection on the
back of the machine.

4

Plug the other end of the Ethernet cable
into the hub.

5

Hold down the power switch for
approximately one second to turn on the
power.

For the computer
IP address :

192.168.0.1~254

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

For the machine

4

IP Address Set :

Manual

IPv4 Address :

192.168.0.1~254
(select a different value
from the computer)

Subnet Mask :

255.255.255.0

Gateway Address :

0.0.0.0

Network Scale :

Small

Scanning

●● To set [Network Scale], press the <SETTING> key
and then select [Admin Setup] > [Network Menu] >
[Network Setup] > [Network Scale].

Connecting using wired LAN:

1

Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

2

Hold down the power switch for
approximately one second to turn off the
power.
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Connecting using wireless LAN
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only):

6

Press the
press OK .

to select [Yes], and then

Use the WPS (push button) function to set the
wireless LAN. For details on other methods
for setting the wireless LAN, refer to the
Configuration Guide.

1
2

Press the <SETTING> key on the operator
panel.

Memo

●● Start the WPS push button for wireless AP after clicking
[Yes] in the confirmation screen. Alternatively, if WPS
push button for wireless AP is started first, start the
WPS push button on this equipment.

Press the to select [Wireless Setting],
and then press the .

●● If [No] is selected, the screen returns to that from
step 5.

7
Log in by entering administrator password
of the device.

Use , , ,
key to select letter and then
press OK .
Default administrator password is “aaaaaa”.

Note

●● Panel operations cannot be performed during WPS
execution.
●● When [WPS connection successful] is displayed,
this equipment is connected to the wireless LAN.

The message below will be displayed for
about 5 seconds.

Memo

4

Check that [Automatic setup (WPS)]
is selected, and then press the .

5

Press the to select [WPS-PBC], and
then press OK .

●● If [Connection failed Timeout] is displayed, it
is possible that the wireless AP of the connection
destination could not be found within the time limit.
Select [Yes] again in step 6 within 2 minutes of
starting WPS push button for wireless AP.

●● If [Overlap] is displayed, WPS-push button is being
executed on 2 or more wireless AP. Please wait for a
short time and then retry.
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3

If [Yes] is selected in step 6, [Running
pushbutton method...] is displayed in
the screen.

4

Scanning to Computer

Setting the IP address:

1

4

Press the <SETTING> key on the
operator panel.

2

Press the
press OK .

3

Enter the administrator password.

to select [Easy Setup], and

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

to select [Enter]

OK

Press the to select [Network
Setting], and then press the .

5

If setting the IP address manually, check
that [Manual] is selected, and press OK .

Scanning

4

If obtaining the IP address automatically, press
the
to select [Auto], and press OK . Proceed to
step 10.

The factory default password is “aaaaaa”.

a

b

Press , , , to select the
character you want, and then
press OK .

6

Enter the IP address using the ten-key
pad, and press OK .

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.
To move to the next box, press the

7

Enter the subnet mask using the ten-key
pad, and press OK .
To move to the next box, press the

8

.

Enter the default gateway address using
the ten-key pad, and press OK .
To move to the next box, press the
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9

Enter the DNS server and WINS server if
needed.
If it is not necessary to connect the DNS server
or WINS server to the network, press OK until the
pop-up message showing setting completion is
displayed.

10 When the setup menu screen is
displayed, press
setup.

Step 2 Installing Your Machine to the
Computer
Memo

●● The following procedure installs the WIA driver as a
scanner driver automatically.

1

Click [Start] and select [Control
Panel].

2

Select [Network and Internet] >
[Network and Sharing Center].

3

Select [Change advanced sharing
settings].

4

Check that [Turn on network
discovery] is selected.

5

Close the Control Panel.

6

Click [Start] and select [Network].

to complete the

that [Yes] is selected and press

OK

Scanning

11 For the confirmation message, check
.

◆◆Print the Network Information to check that
the IP address and other network information
are properly set.

1

Press the <SETTING> key on the
operator panel.

The devices connected to the network are
displayed.

2

Check that [Reports] is selected and
press OK .

3

Press the
press OK .

4

Press the to select [Network
Information] and press OK .

5

For the confirmation message, check
that [Yes] is selected and press OK .

4

7

Right-click the MC362 icon under
[Multifunction Devices] and select
[Install].
If the [User Account Control] dialog box is
displayed, click [Yes].

to select [System] and

The Network Information is printed.
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8

For Mac OS X

When the balloon message saying that
the installation is complete is displayed
on the task bar, click the balloon to
check the details, and click [Close].

 Overview
Connecting Methods
You can select either of the following connection
methods:
●● Network Connection
●● USB Connection

Product Requirements

4

9

Your machine supports Mac OS X 10.6 to 10.8.

Press the <SCAN> key on the operator
panel.

Steps to Go

Scanning

To configure the Scan to Computer function with
Mac OS X, follow the 3 steps below:
●● “Step 1 Connecting Your Machine and
Computer” P.91
●● “Step 2 Installing a Scanner Driver” P.95
●● “Step 3 Registering Your Computer in Network
Scanner Setup Tool” P.96
Memo

10 Press the

then press

●● For the network connection, you can skip step 1 if the IP
address is already set on your machine.

to select [Computer] and
.

●● You can skip step 2 if the scanner driver is already
installed on your computer.

OK

●● For the USB connection, skip step 3.

11 Check that [Select A Connecting PC]
is selected, and press

OK

.

12 Press the

to select [From WSD
Scan], and press OK .

13 Check that the computer on which your
machine has been installed is displayed
as the destination PC.

Note

●● If the machine’s IP address is changed after the
installation, uninstall the machine from the computer by
following the same procedure as in “Step 2 Installing Your
Machine to the Computer” P.89, and then reinstall it.
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 Step 1 Connecting Your Machine
and Computer

Memo

●● If configuring a small network consisting of only your
machine and a computer, set IP addresses as shown
below (according to RFC1918).

Select the connection method and follow each
procedure.

For the computer

●● “For Network Connection” P.91

IP address :

●● “For USB Connection” P.95

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

For Network Connection

192.168.0.1~254

For the machine

Connect your machine to a network with an
Ethernet cable or Wireless LAN connection
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only), and then
configure the machine’s IP address and other
network information from the operator panel.
You can set the IP address either manually or
automatically.

If your network administrator or internet
service provider specifies a unique IP address
for the computer and your machine, set the IP
addresses manually.

Manual

IPv4 Address :

192.168.0.1~254
(select a different value
from the computer)

Subnet Mask :

255.255.255.0

Gateway Address :

0.0.0.0

Network Scale :

Small

●● To set [Network Scale], press the <SETTING> key
and then select [Admin Setup] > [Network Menu] >
[Network Setup] > [Network Scale].

Connecting using wired LAN

1

Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

Note

●● You need to configure the network setting of the computer
before this procedure.
●● When setting an IP address manually, ask the network
administrator or your internet service provider which IP
address to use. If the IP address is set incorrectly, the
network may go down or Internet access may be disabled.
●● To configure the Scan to Computer function via the
network connection, follow these instructions.

2

--Conform the IP version of the machine to that of your
computer.
--Set [TCP/IP] setting to [Enable] on your machine.
(By factory default, it is set to [Enable].)
--Set [Network TWAIN] setting to [ON] on your
machine. (By factory default, it is set to [ON]. If
it has been disabled, enable it by referring to the
Configuration Guide > “Configuring the Scan to
Computer and Remote Scan” > “Using Functions for
Scan to Computer and Remote Scan” > “Enabling the
Network TWAIN Setting”.)
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Hold down the power switch for
approximately one second to turn off the
power.

4
Scanning

If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or machine.

IP Address Set :

Scanning to Computer

3

Plug one end of the Ethernet cable into
the network interface connection on the
back of the machine.

Connecting using wireless LAN
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only)
Use the WPS (push button) function to set the
wireless LAN. For details on other methods
for setting the wireless LAN, refer to the
Configuration Guide.

1

Press the <SETTING> key on the operator
panel.

2

Press the to select [Wireless Setting],
and then press the .

3

Log in by entering administrator password
of the device.

4
Scanning

4

Plug the other end of the Ethernet cable
into the hub.

Use , , ,
key to select letter and then
press OK .
Default administrator password is “aaaaaa”.

The message below will be displayed for
about 5 seconds.

5

Hold down the power switch for
approximately one second to turn on the
power.

4

Check that [Automatic setup (WPS)]
is selected, and then press the .

5

Press the to select [WPS-PBC], and
then press OK .
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6

Press the
press OK .

to select [Yes], and then

Setting the IP address

1

Press the <SETTING> key on the
operator panel.

2

Press the
press OK .

3

Enter the administrator password.

Memo

●● Start the WPS push button for wireless AP after clicking
[Yes] in the confirmation screen. Alternatively, if WPS
push button for wireless AP is started first, start the
WPS push button on this equipment.
●● If [No] is selected, the screen returns to that from
step 5.

7

4
Scanning

If [Yes] is selected in step 6, [Running
pushbutton method...] is displayed in
the screen.

to select [Easy Setup], and

The factory default password is “aaaaaa”.

Note

●● Panel operations cannot be performed during WPS
execution.

a

●● When [WPS connection successful] is displayed,
this equipment is connected to the wireless LAN.

Press , , , to select the
character you want, and then
press OK .

Memo

●● If [Connection failed Timeout] is displayed, it
is possible that the wireless AP of the connection
destination could not be found within the time limit.
Select [Yes] again in step 6 within 2 minutes of
starting WPS push button for wireless AP.

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

●● If [Overlap] is displayed, WPS-push button is being
executed on 2 or more wireless AP. Please wait for a
short time and then retry.
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4

4

5

b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
OK .

9

Enter the DNS server and WINS server if
needed.
If it is not necessary to connect the DNS server
or WINS server to the network, press OK until
the pop-up message of showing the setting
completion is displayed.

to select [Enter]

Press the to select [Network
Setting], and then press the .

10 When the setup menu screen is
displayed, press
setup.

Scanning

If setting the IP address manually, check
that [Manual] is selected, and press OK .

to complete the

11 For the confirmation message, check
that [Yes] is selected and press

OK

.

◆◆Print the Network Information to check that
the IP address and other network information
are properly set.
If obtaining the IP address automatically, press
the
to select [Auto], and press OK . Proceed to
step 10.

6

2

Check that [Reports] is selected and
press OK .

3

Press the
press OK .

4

Press the to select [Network
Information] and press OK .

.

5

For the confirmation message, check
that [Yes] is selected and press OK .

Enter the subnet mask using the ten-key
pad, and press OK .
To move to the next box, press the

8

Press the <SETTING> key on the
operator panel.

Enter the IP address using the ten-key
pad, and press OK .

To move to the next box, press the

7

1

.

Enter the default gateway address using
the ten-key pad, and press OK .
To move to the next box, press the

.
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to select [System] and

The Network Information is printed.

Scanning to Computer

4

For USB Connection

1

Plug the other end of the USB cable into
the computer’s USB interface connector.

Prepare a USB cable.
A USB cable is not supplied with your machine.
Prepare a USB 2.0 cable separately.

Memo

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 HiSpeed connection.

2

Hold down the power switch for
approximately one second to turn off the
power. And turn off the computer.

Note

 Step 2 Installing a Scanner Driver

3

Plug one end of the USB cable into the
USB interface connector on the back of
the machine.

1

Check that the machine is connected to
the computer and the machine is turned
on. Then, load the “Software DVD-ROM”
on the drive of the computer.

2

Double-click [OKI] on the desktop.

3

Double-click [Drivers] > [Scanner] >
[Installer for OS X 10.8] (for Mac OS
X 10.8) or [Installer for OS X 10.310.7] (for Mac OS X 10.3.9 to 10.7).

4

Click [Continue].

5

Click [Continue].
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●● Do not plug the USB cable into the network interface
connection. Doing so may damage your machine.

4

Scanning to Computer

6

Check the display and click [Continue]
if OK.

11 Click [Continue Installation].

12 Click [Restart].

4

7

Read the license agreement and click
[Continue].

Scanning

 Step 3 Registering Your Computer
in Network Scanner Setup Tool
To use the Scan to Computer function via the
network connection, be sure to register your
computer as a destination in Network Scanner
Setup Tool before starting a scan job.
Memo

8

9

Click [Agree] if you agree.

Click [Install].
To change the installation location of the driver,
click [Change Install Location].

●● Network Scanner Setup Tool is installed simultaneously
when installing the scanner driver.

1

From the [Go] menu, select
[Applications] > [OKIDATA] >
[Scanner] > [Network Scanner Setup
Tool].

2

Select your machine from [Device List]
and click [Register].

3

Edit [Name] which is displayed as
a destination on your machine if
necessary, and click [Register].

4

For the confirmation message, click
[OK].

5

Click [OK] to close the Network Scanner
Setup Tool.

10 Enter the administrator’s name and
password and then click [Install
Software].
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Procedure for Scan to Computer

2

This section explains how to start Scan to
Computer. The following procedure is common
for Windows and Mac OS X.

Place your document in the ADF or on
the document glass as below:
●● ADF
Load documents face up with the top edge of the
documents in first.

You need to configure the initial settings before
using the Scan to Computer function.
Select the connection method and follow each
procedure.
●● “For Network Connection” P.97
●● “For USB Connection” P.98
●● “For WSD Scan Connection (Windows only)”
P.100

Adjust the document guides to the width of your
documents.

Note

●● Document Glass
Place the document face down and align its top
edge to the upper-left corner of the glass.

●● If the Mac OS X is running, you can save a file only as
JPEG.

 For Network Connection
Note

●● For Mac OS X 10.7 to 10.8, if you scan documents
through network connection, you need to start the Image
Capture first. Then, you need to select the machine from
the list displayed at the left of Image Capture screen.

1

Press the <SCAN> key on the operator
panel.
Close the document glass cover gently.
Note

●● Do not apply an excessive load to the document
glass.

Memo

●● The machine prioritizes the ADF when scanning
documents. Be sure not to place documents on the
ADF when you use the document glass.
Note

●● If Carriage Error <02> is displayed, press Power
OFF/ON.

- 97 -

Scanning

●● If the Mac OS X is running, you can scan a document in
the fixed A4 size only on the document glass.

4

Scanning to Computer

3

4

 For USB Connection

Press the to select [Computer] and
then press OK .

Scanning

4

Check that [Select A Connecting PC]
is selected and then press OK .

5

Check that [From Network] is selected
and then press OK .

6

Press the to select the computer you
want and then press OK .

7

Press the to select [Select An
Application] and then press OK .

8

Press the to select where to send the
scanned document and then press OK .

1

Selectable location Values to send:
Application Folder
PC-FAX
Note

●● For Mac OS X, you can select [Folder] only.

9

Press

MONO

or

COLOR

.

ActKey (for Windows) or Image Capture (for
Mac OS X) starts, and the scan job starts
automatically on the computer. When scanning is
done, the scanned image is processed as below:

-- If you select [Application], the specified
application starts and the scanned image
is displayed on the application.
-- If you select [Folder], the scanned image
is saved in the specified folder.
-- If you select [PC-FAX], the application for
fax transmission starts. After sending the
scanned image, send a fax with the fax
transmission software on your computer.
Reference

●● To load a landscape document, refer to the User’s Guide >
“Operation” > “Loading document(s)”.
●● You can customize the scan button settings of ActKey. For
details, refer to the Configuration Guide > “Configuring
the Scan to Computer and Remote Scan” > “Using Drivers
and Software” > “Using ActKey Software” > “Setting the
Scan Button”.
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Press the <SCAN> key on the operator
panel.

Scanning to Computer

2

Place your document in the ADF or on
the document glass as below:

3

Press the to select [Computer] and
then press OK .

4

Check that [Select A Connecting PC]
is selected and then press OK .

5

Press the to select [From USB
Interface] and then press OK .

●● ADF
Load documents face up with the top edge of the
documents in first.

Adjust the document guides to the width of your
documents.

Press the to select [Select An
Application] and then press OK .

7

Press the to select where to send the
scanned document and then press OK .

●● Document Glass
Place the document face down and align its top
edge to the upper-left corner of the glass.

Selectable location Values to send:
Application Folder
PC-FAX
Note

●● For Mac OS X, you can select [Folder] only.

8

Press

MONO

or

COLOR

.

ActKey (for Windows) or Image Capture (for
Mac OS X) starts, and the scan job starts
automatically on the computer. When scanning is
done, the scanned image is processed as below:
Close the document glass cover gently.

-- If you select [Application], the specified
application starts and the scanned image
is displayed on the application.

Note

●● Do not apply an excessive load to the document
glass.

-- If you select [Folder], the scanned image
is saved in the specified folder.
-- If you select [PC-FAX], the application for
fax transmission starts. After sending the
scanned image, send a fax with the fax
transmission software on your computer.
Reference

●● To load a landscape document, refer to the User’s Guide >
“Operation” > “Loading document(s)”.

Memo

●● The machine prioritizes the ADF when scanning
documents. Be sure not to place documents on the
ADF when you use the document glass.

●● You can customize the scan button settings of ActKey. For
details, refer to the Configuration Guide > “Configuring
the Scan to Computer and Remote Scan” > “Using Drivers
and Software” > “Using ActKey Software” > “Setting the
Scan Button”.

Note

●● If Carriage Error <02> is displayed, press Power
OFF/ON.
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6

4

Scanning to Computer

 For WSD Scan Connection
(Windows only)
1

4

Note

●● Do not apply an excessive load to the document
glass.

Press the <SCAN> key on the operator
panel.

Memo

2

●● The machine prioritizes the ADF when scanning
documents. Be sure not to place documents on the
ADF when you use the document glass.

Place your document in the ADF or on
the document glass as below:

Scanning

●● ADF

Note

Load documents face up with the top edge of the
documents in first.

Adjust the document guides to the width of your
documents.

●● Document Glass
Place the document face down and align its top
edge to the upper-left corner of the glass.

●● If Carriage Error <02> is displayed, press Power
OFF/ON.

3

Press the to select [Computer] and
then press OK .

4

Check that [Select A Connecting PC]
is selected and then press OK .

5

Press the to select [From WSD Scan]
and then press OK .

6

Press the to select the event for the
destination computer and then press OK .
Selectable events:
Scan for E-mail to XXX
Scan for Fax to XXX
Scan for OCR to XXX
Scan for Print to XXX
Scan to XXX
XXX indicates the name of the destination computer.

Close the document glass cover gently.

You can set an action for each event in Windows
scan properties.
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7

Press

MONO

or

COLOR

.

The scan job is processed according to the action
set for the selected event.
Reference

●● To load a landscape document, refer to the User’s Guide >
“Operation” > “Loading document(s)”.
●● You can scan double-sided documents. For details on
dual-side scanning, refer to the User’s Guide >
“Scanning” > “Scan to Computer” > “WSD Scan
connection”.

4
Scanning
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5 Printing
This chapter explains the initial setup and basic procedure for the Print from Computer function.
Your machine supports the following print functions.
Function
“Printing from a Computer”

Printing from USB Memory

Overview
Prints a document sent from a computer connected via USB or network. The
printer driver must be installed on the computer to use this function.
*AirPrint does not require drivers to be installed.
Prints a document saved in a USB memory which is inserted to the USB port of
the machine.
For the procedure of the function, refer to the User’s Guide > “Printing” >
“Printing From USB Memory”.

●●
Printing from a Computer
5

This section explains how to install a printer driver and the basic procedure for printing documents from
a computer.

Printing

Be sure to install a printer driver before using this function.

Installing a Printer Driver

Product Requirements
Your machine supports the following Windows
operating systems:

This section explains how to install a printer
driver on your computer.
Refer to the procedure for the OS you are using.

●● Windows 8/Windows 8 (64bit Version)
●● Windows Server 2012

●● “For Windows” P.102

●● Windows 7/Windows 7 (64bit Version)

●● “For Mac OS X” P.111

●● Windows Vista/Windows Vista (64bit Version)

For Windows

●● Windows Server 2008 R2
●● Windows Server 2008/Windows Server 2008
(x64 Version)

 Overview

●● Windows XP/Windows XP (x64 Version)

Connecting Methods
You can select either of the following connection
methods:
●● “For Network Connection” P.103
●● “For USB Connection” P.109

●● Windows Server 2003/Windows Server 2003
(x64 Version)

Types of Printer Drivers
The printer driver types that can be installed are
as follows.
Type
PCL
PS
PCL XPS

Description
The PCL printer driver is suitable for
printing business documents.
The PS printer driver is suitable for
the printing of documents including
PostScript fonts and EPS data.
The PCL XPS printer driver is suitable for
printing from an application for XPS.
* I t does not support Windows XP/Windows
Server 2003.

Memo

●● The description may be differ depending on a version of a
printer driver or Windows.
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 For Network Connection

●● T
 o set [Network Scale], press the <SETTING> key
and then select [Admin Setup] > [Network Menu] >
[Network Setup] > [Network Scale].

To install a printer driver on your computer
via the network connection, follow the 2 steps
below:

Connecting using wired LAN:

●● “Step 1 Configuring the Network Settings of
Your Machine” P.103

1

Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.

●● “Step 2 Installing a Printer Driver” P.106
Note

●● You need to complete the network setting of the computer
before this procedure.
Memo

●● You can skip the step 1 if the IP address is already set on
your machine.
●● You can skip the step 2 if the printer driver is already
installed on your computer.

2

Step 1 Configuring the Network
Settings of Your Machine

5
Printing

Connect your machine to a network with an
Ethernet cable or Wireless LAN connection
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only), and then
configure the machine’s IP address and other
network information from the operator panel.
You can set the IP address either manually or
automatically.
If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or machine.
If your network administrator or internet
service provider specifies a unique IP address
for the computer and your machine, set the IP
addresses manually.

3

Note

●● When setting an IP address manually, ask the network
administrator or your internet service provider which
IP address to use. If the IP address is set wrong, the
network may go down or Internet access may be disabled.
●● Conform the IP version of the machine to that of your
computer.
●● Set [TCP/IP] setting to [Enable] on your machine. (By
factory default, it is set to [Enable].)
Memo

●● If configuring a small network consisting of only your
machine and a computer, set IP addresses as shown
below (according to RFC1918).
For the computer
IP address :

192.168.0.1~254

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

For the machine
IP Address Set :

Manual

IPv4 Address :

192.168.0.1~254
(select a different value
from the computer)

Subnet Mask :

255.255.255.0

Gateway Address :

0.0.0.0

Network Scale :

Small

Hold down the power switch for
approximately one second to turn off the
power. And turn off the computer.
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Plug one end of the Ethernet cable into
the network interface connection on the
back of the machine.

Printing from a Computer

4

Plug the other end of the Ethernet cable
into the hub.

3

Log in by entering administrator password
of the device.
Use , ,
press OK .

,

key to select letter and then

Default administrator password is “aaaaaa”.

The message below will be displayed for
about 5 seconds.

5

5

Hold down the power switch for
approximately one second to turn on the
power.

Printing

Connecting using wireless LAN
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only):

4

Check that [Automatic setup (WPS)]
is selected, and then press the .

5

Press the to select [WPS-PBC], and
then press OK .

6

Press the
press OK .

Use the WPS (push button) function to set the
wireless LAN. For details on other methods
for setting the wireless LAN, refer to the
Configuration Guide.

1
2

Press the <SETTING> key on the operator
panel.
Press the to select [Wireless Setting],
and then press the .

to select [Yes], and then

Memo

●● Start the WPS push button for wireless AP after clicking
[Yes] in the confirmation screen. Alternatively, if WPS
push button for wireless AP is started first, start the
WPS push button on this equipment.
●● If [No] is selected, the screen returns to that from
step 5.
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7

If [Yes] is selected in step 6, [Running
pushbutton method...] is displayed in
the screen.

Note

2

Press the
press OK .

3

Enter the administrator password.

to select [Easy Setup], and

The factory default password is “aaaaaa”.

●● Panel operations cannot be performed during WPS
execution.

a

●● When [WPS connection successful] is displayed,
this equipment is connected to the wireless LAN.

Press , , , to select the
character you want, and then
press OK .

5
Printing

Memo

●● If [Connection failed Timeout] is displayed, it
is possible that the wireless AP of the connection
destination could not be found within the time limit.
Select [Yes] again in step 6 within 2 minutes of
starting WPS push button for wireless AP.

-- The selected character is entered as “*” in
the text field.
-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

●● If [Overlap] is displayed, WPS-push button is being
executed on 2 or more wireless AP. Please wait for a
short time and then retry.
●● less AP. Please wait for a short time and then retry.

Setting the IP address:

1

Press the <SETTING> key on the
operator panel.

4
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b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

to select [Enter]

OK

Press the to select [Network
Setting], and then press the .

Printing from a Computer

5

If setting the IP address manually, check
that [Manual] is selected, and press OK .

If obtaining the IP address automatically, press
the
to select [Auto], and press OK . Proceed to
step 10.

6

Enter the IP address using the ten-key
pad, and press OK .

10 When the setup menu screen is
displayed, press
setup.

to complete the

11 For the confirmation message, check
that [Yes] is selected and press

OK

.

◆◆Print the Network Information to check that
the IP address and other network information
are properly set.

5

Press the <SETTING> key on the
operator panel.

2

Check that [Reports] is selected and
press OK .

3

Press the
press OK .

4

Press the to select [Network
Information] and press OK .

5

For the confirmation message, check
that [Yes] is selected and press OK .

Printing

1

To move to the next box, press the

7

Enter the subnet mask using the ten-key
pad, and press OK .
To move to the next box, press the

8

.

Enter the default gateway address using
the ten-key pad, and press OK .
To move to the next box, press the

9

.

.

The Network Information is printed.

Enter the DNS server and WINS server if
needed.
If it is not necessary to connect the DNS server
or WINS server to the network, press OK until the
pop-up message showing setting completion is
displayed.

to select [System] and

Step 2 Installing a Printer Driver
Note

●● To complete this procedure, you must be logged in as an
administrator.

1
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Check that your machine and the
computer are turned on and connected,
and then insert the “Software DVD-ROM”
into the computer.

Printing from a Computer

2

Click [Run Setup.exe] after [AutoPlay]
is displayed.

7

If the [User Account Control] dialog box is
displayed, click [Yes].

3

Select the language.

4

Select the device of your machine, and
then click [Next].

Read the license agreement and then
click [I Agree].

6

Read the “Environmental advice for
Users” and click [Next].

Memo

●● By factory default, [PCL driver], [Scanner driver],
and [ActKey] are selected.

8

If the [Windows Security] dialog box
is displayed, click [Install this driver
software anyway].

9

Click the [Network] button.
The device search starts.

-- If the machine is detected, it is
automatically installed. Proceed to step
11.
-- If the machine is not detected, the
[Review your installation settings.]
screen is displayed. Proceed to step 10.
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5

Select the checkbox for the printer
driver you want to install, and click the
Install bunch button.

Printing from a Computer

10 Click [Restart search] to restart the
device search.

1

Click [Start] > [Devices and Printers].

2

Right-click the OKI MC562 icon and
select [Printer properties] (> a desired
printer driver if you have installed
multiple drivers) from the pop-up menu.

3

On the [General] tab, click [Print Test
Page].

After the machine is displayed, select the machine
and click [Next].

5
Printing

Memo

●● If the machine is not displayed by clicking [Restart
search], select [Printer name/IP Address] and
enter the IP address assigned to your machine, and
then click [Next].

11 If the [Windows Security] dialog box
is displayed, click [Install this driver
software anyway].

12 Click the [Exit] button.

13 Remove the “Software DVD-ROM” from
the computer.

The installation is complete.

◆◆Print a test page to check that the printer
driver is successfully installed on the
computer.
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 For USB Connection

5

Follow the procedure below to connect a
USB cable and install a printer driver on your
computer.

Insert “Software DVD-ROM” into the
computer.

6

Click [Run Setup.exe] after [AutoPlay]
is displayed.

Note

If the [User Account Control] dialog box is
displayed, click [Yes].

●● You must be logged in as an administrator to complete
this procedure.
Memo

●● You can skip this procedure if the printer driver is already
installed on your computer.

1

7

Select the language.

8

Select the device of your machine, and
then click [Next].

Prepare a USB cable.
A USB cable is not supplied with your machine.
Prepare a USB 2.0 cable separately.

5

Memo

2

Hold down the power switch for
approximately one second to turn off the
power.

Printing

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 HiSpeed connection.

9

Read the license agreement and then
click [I Agree].

10 Read the “Environmental advice for
Users” and click [Next].

3

Plug one end of the USB cable into the
USB interface connector on the back of
the machine.

4

Turn on the computer.
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11 Select the checkbox for the printer

13 When the instruction to connect the

driver you want to install, and click the
Install bunch button.

machine to the computer and turn on
the machine is displayed, plug the other
end of the USB cable into the computer’s
USB interface connector and hold down
the power switch for about a second to
turn on the power.

Memo

●● By factory default, [PCL driver], [Scanner driver],
and [ActKey] are selected.

5

12 If the [Windows Security] dialog box

Printing

is displayed, click [Install this driver
software anyway].

Note

●● Do not plug the USB cable into the network interface
connection. Doing so may damage your machine.

14 Click the [Exit] button.
15 Remove “Software DVD-ROM” from the
computer.

The installation is complete.
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For Mac OS X

◆◆Print a test page to check that the printer
driver is successfully installed on the
computer.

 Overview

1

Click [Start] > [Devices and Printers].

2

Right-click the OKI MC562 icon and
select [Printer properties] (> a desired
printer driver if you have installed
multiple drivers) from the pop-up menu.

3

On the [General] tab, click [Print Test
Page].

Connecting Methods
You can select either of the following connection
methods:
●● “For Network Connection” P.111
●● “For USB Connection” P.119

Product Requirements
Your machine supports Mac OS X 10.3.9 to 10.8.

Types of Printer Drivers
The driver types that can be installed are as
follows.
Type

Description
The PS printer driver is suitable for
the printing of documents including
PostScript fonts and EPS data.
It can be also used for normal printing.

AirPrint support
Mac OS X 10.7 and later are supported.
Note

●● The description may be different depending on the version
of a printer driver or Mac OS X.

 For Network Connection
To install a printer driver on your computer
via the network connection, follow the 3 steps
below:
●● “Step 1 Configuring the Network Settings of
Your Machine” P.112
●● “Step 2 Installing a Printer Driver” P.116
The following procedure uses Bonjour as a
network protocol.
Note

●● You need to complete the network setting of the computer
before this procedure.
Memo

●● You can skip the step 1 if the IP address is already set on
your machine.
●● You can skip the step 3 if the printer driver is already
installed on your computer.
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5
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Step 1 Configuring the Network
Settings of Your Machine

2

Hold down the power switch for
approximately one second to turn off the
power. And turn off a computer.

3

Plug one end of the Ethernet cable into
the network interface connection on the
back of the machine.

4

Plug the other end of the Ethernet cable
into the hub.

Connect your machine to a network with an
Ethernet cable or Wireless LAN connection
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only), and then
configure the machine’s IP address and other
network information from the operator panel.
You can set the IP address either manually or
automatically.
If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or machine.
If your network administrator or internet
service provider specifies a unique IP address
for the computer and your machine, set the IP
addresses manually.

5

Note

Printing

●● When setting an IP address manually, ask the network
administrator or your internet service provider which IP
address to use. If the IP address is set incorrectly, the
network may go down or Internet access may be disabled.
●● Conform the IP version of the machine to that of your
computer.
●● Set [TCP/IP] setting to [Enable] on your machine. (By
factory default, it is set to [Enable].)
Memo

●● If configuring a small network consisting of only your
machine and a computer, set IP addresses as shown
below (according to RFC1918).
For the computer
IP address :

192.168.0.1~254

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

For the machine
IP Address Set :

Manual

IPv4 Address :

192.168.0.1~254
(select a different value
from the computer)

Subnet Mask :

255.255.255.0

Gateway Address :

0.0.0.0

Network Scale :

Small

●● To set [Network Scale], press the <SETTING> key
and then select [Admin Setup] > [Network Menu] >
[Network Setup] > [Network Scale].

Connecting using wired LAN:

1

Prepare an Ethernet cable and a hub.
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.
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5

Hold down the power switch for
approximately one second to turn on the
power.

Connecting using wireless LAN
(MC342dw, MC362w, MC562w, MC562dw,
ES5462dw MFP, MPS2731mc only):

4

Check that [Automatic setup (WPS)]
is selected, and then press the .

5

Press the to select [WPS-PBC], and
then press OK .

6

Press the
press OK .

1

Press the <SETTING> key on the operator
panel.

2

Press the to select [Wireless Setting],
and then press the .

Memo

●● Start the WPS push button for wireless AP after clicking
[Yes] in the confirmation screen. Alternatively, if WPS
push button for wireless AP is started first, start the
WPS push button on this equipment.
●● If [No] is selected, the screen returns to that from
step 5.

7
3

Log in by entering administrator password
of the device.
Use , ,
press OK .

,

5
Printing

Use the WPS (push button) function to set the
wireless LAN. For details on other methods
for setting the wireless LAN, refer to the
Configuration Guide.

to select [Yes], and then

If [Yes] is selected in step 6, [Running
pushbutton method...] is displayed in
the screen.

key to select letter and then

Default administrator password is “aaaaaa”.

Note

●● Panel operations cannot be performed during WPS
execution.
●● When [WPS connection successful] is displayed,
this equipment is connected to the wireless LAN.

The message below will be displayed for
about 5 seconds.
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3

Memo

●● If [Connection failed Timeout] is displayed, it
is possible that the wireless AP of the connection
destination could not be found within the time limit.
Select [Yes] again in step 6 within 2 minutes of
starting WPS push button for wireless AP.

Enter the administrator password.
The factory default password is “aaaaaa”.

a

Press , , , to select the
character you want, and then
press OK .

●● If [Overlap] is displayed, WPS-push button is being
executed on 2 or more wireless AP. Please wait for a
short time and then retry.

Setting the IP address:

1

5

-- The selected character is entered as “*” in
the text field.

Press the <SETTING> key on the
operator panel.

-- If you have entered an incorrect value,
press the <CLEAR> key and then enter
the correct value.

Printing

2

Press the
press OK .

to select [Easy Setup], and

4
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b

Repeat step a until all characters
required are entered.

c

Press the
and press

and
.

to select [Enter]

OK

Press the to select [Network
Setting], and then press the .

Printing from a Computer

5

If setting the IP address manually, check
that [Manual] is selected, and press OK .

If obtaining the IP address automatically, press
the
to select [Auto], and press OK . Proceed to
step 10.

6

10 When the setup menu screen is
displayed, press
setup.

to complete the

11 For the confirmation message, check
that [Yes] is selected and press

OK

.

Enter the IP address using the ten-key
pad, and press OK .

5
Printing

To move to the next box, press the

7

Enter the subnet mask using the ten-key
pad, and press OK .
To move to the next box, press the

8

.

Enter the default gateway address using
the ten-key pad, and press OK .
To move to the next box, press the

9

.

.

Enter the DNS server and WINS server if
needed.
If it is not necessary to connect the DNS server
or WINS server to the network, press OK until
the pop-up message of showing the setting
completion is displayed.
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◆◆Print the Network Information to check that
the IP address and other network information
are properly set.

5
Printing

1

Press the <SETTING> key on the
operator panel.

2

Check that [Reports] is selected and
press OK .

3

Press the
press OK .

4

Press the to select [Network
Information] and press OK .

5

For the confirmation message, check
that [Yes] is selected and press OK .

7

Click [+] and select [Add Other Printer
or Scanner] on the pop-up menu.
For Mac OS X 10.5 and 10.6, click [+].

8

Click [Default].

9

Select the name of your machine whose
[Kind] is [Bonjour], and then check
that [OKI MC562(PS)] is displayed in
[Print Using].

to select [System] and

The Network Information is printed.

Step 2 Installing a Printer Driver
◆◆For Mac OS X 10.5 to 10.8

The name of your machine is displayed “OKIMC562- (the last six digits of the MAC address)”.

1

Check that your machine and the
computer are turned on and connected.

2

Insert “Software DVD-ROM” into the
computer.

3

Double-click the [OKI] icon on the
desktop.

4

Double-click [Drivers] folder > [PS]
folder > [Installer for OSX10.5-10.8].
Follow the instructions displayed on the screen to
complete the installation.

5

From the Apple menu, select [System
Preferences].

6

Click [Print & Scan] (For Mac OS X
10.5 and 10.6: [Print & Fax]).

10 Click [Add].
11 If the [Installable Options] window is
displayed, click [Continue].
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12 Check that your machine is displayed in

3

Select [Network].

4

Select [Network Port Configurations]
from [Show], and then check that
[Built-in Ethernet] is selected.

5

Close [Network].

13 Close [Print & Scan] (For Mac OS X

6

Insert “Software DVD-ROM” into the
computer.

14 Remove “Software DVD-ROM” from the

7

Double-click the [OKI] icon on the
desktop.

8

Double-click [Driver] folder > [PS]
folder > [Installer for OSX10.3-10.4].

[Printers] and [OKI MC562(PS)] is
displayed in [Kind].

Note

●● If [OKI MC562(PS)] is not correctly displayed
in [Kind], click [-] to remove your machine from
[Printers] and then redo the procedure from step 8
to 12.

computer.

The installation is complete.

◆◆Print a test page to check that the printer
driver is successfully installed on the
computer.

1

From the [Go] menu, select
[Applications] > [TextEdit].

2

Select the [File] menu > [Print].

3

Select the name of your machine from
[Printer].

4

Follow the instructions displayed on the screen to
complete the installation.

9

From the [Go] menu, select [Utilities]
and then double-click [Printer Setup
Utility].
Note

●● If [Printer Setup Utility] is already running, close it
once and reopen.

10 Click [Add].

Click [Print].

◆◆For Mac OS X 10.3.9 to 10.4.11
Memo

●● The following procedure uses Mac OS X 10.4.11 as an
example. The description may be differ depending on the
OS.

1

Check that your machine and the
computer are turned on and connected.

2

From the Apple menu, select [System
Preferences].

If the [You have no printers available] dialog
box is displayed, click [Add].
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10.5 and 10.6: [Print & Fax]).

5
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11 Select the name of your machine whose
[Connection] is [Bonjour], and then
check that [OKI MC562(PS)] is
displayed in [Print Using].

4

Check that [OKI MC562(PS)] is
displayed correctly under [Format for].

5

Click [OK].

6

Select the [File] menu > [Print].

7

Select the name of your machine from
[Printer].

8

Click [Print].

The name of your machine is displayed “OKIMC562- (the last six digits of the MAC address)”.

5

◆◆For Mac OS X 10.7-10.8 AirPrint

Printing

12 Click [Add].

1

Check that your machine and the
computer are turned on and connected.

2

From the Apple menu, select [System
Preferences].

3

Click [Print & Scan].

4

Click [+] and select [Add Other Printer
or Scanner] on the pop-up menu.

13 If the [Installable Options] window is
displayed, click [Continue].

14 Check that the name of your machine

is displayed in [Printer List], and then
close the window.

15 Remove “Software DVD-ROM” from the
computer.

The installation is complete.

◆◆Print a test page to check that the printer
driver is successfully installed on the
computer.

1

From the [Go] menu, select
[Applications] > [TextEdit].

2

Select the [File] menu > [Page setup].

3

Select the name of your machine from
[Format for].

- 118 -

Printing from a Computer

5 Select the name of your machine whose
[Kind] is [Bonjour], and then check
that [AirPrint] is displayed in [Use].

 For USB Connection
Follow the procedure below to connect a
USB cable and install a printer driver on your
computer.

For Mac OS X 10.5 to 10.8
Note

●● Disable the anti-virus software before starting this
procedure.

1

Prepare a USB cable.
A USB cable is not supplied with your machine.
Prepare a USB 2.0 cable separately.

Click [Add].

7

Check that your machine is displayed
in [Printers] and [MC562-AirPrint] is
displayed in [Kind].

2

Hold down the power switch for
approximately one second to turn off the
power. And turn off the computer.

Close [Print & Scan]

3

Plug one end of the USB cable into the
USB interface connector on the back of
the machine.

8

Memo

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 HiSpeed connection.

◆◆For iOS AirPrint
For iOS, it is not necessary to add a printer.
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6
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4

Plug the other end of the USB cable into
the computer’s USB interface connector.

11 Click [+] and select [Add Other Printer
or Scanner] on the pop-up menu.
For Mac OS X 10.5 and 10.6, click [+].

Note

●● Do not plug the USB cable into the network interface
connection. Doing so may cause a malfunction.

5

5

Printing

Hold down the power switch for
approximately one second to turn on the
power. And turn on the computer.

Note

●● If the machine is already shown in [Printers], select
your machine, and click on [-] to delete. After this,
click [+].

12 Select the name of your machine whose

[Kind] is [USB], and then check that
[OKI MC562(PS)] is displayed in [Print
Using].

6

Insert “Software DVD-ROM” into the
computer.

7

Double-click the [OKI] icon on the
desktop.

8

Double-click [Drivers] folder > [PS]
folder > [Installer for OSX10.5-10.8].

13 Click [Add].

Follow the instructions displayed on the screen to
complete the installation.

9

From the Apple menu, select [System
Preferences].

10 Click [Print & Scan] (Mac OS X 10.5
and 10.6: [Print & Fax]).
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14 Check that the name of your machine

For Mac OS X 10.3.9 to 10.4.11

is displayed in [Printers] and [OKI
MC562(PS)] is displayed.

Memo

●● The procedure below uses Mac OS X 10.4.11 as an
example. The description may be different depending on
your OS.

1

Prepare a USB cable.
A USB cable is not supplied with your machine.
Prepare a USB 2.0 cable separately.

Memo

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 HiSpeed connection.
Note

●● If [OKI MC562(PS)] is not correctly displayed, click
[-] to remove your machine from [Printers] and
then redo the procedure from steps 11 to 13.

2

Hold down the power switch for
approximately one second to turn off the
power.

3

Plug one end of the USB cable into the
USB interface connector on the back of
the machine.

Printing

15 Close [Print & Scan] (Mac OS X 10.5
and 10.6: [Print & Fax]).

16 Remove “Software DVD-ROM” from the
computer.

The installation is complete.

◆◆Print a test page to check that the printer
driver is successfully installed on the
computer.

1

From the [Go] menu, select
[Applications] > [TextEdit].

2

Select the [File] menu > [Print].

3

Select the name of your machine from
[Printer].

4

Click [Print].

5
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4

Plug the other end of the USB cable into
the computer’s USB interface connector.

10 Click [Add].

If the [You have no printers available] dialog
box is displayed, click [Add].

Note

Note

●● Do not plug the USB cable into the network interface
connection. Doing so may damage your machine.

5

5

Printing

Hold down the power switch for
approximately one second to turn on the
power. And turn on the computer.

6

Insert “Software DVD-ROM”.

7

Double-click the [OKI] icon on the
desktop.

8

Double-click [Driver] folder > [PS]
folder > [Installer for OSX10.3-10.4].

●● If the name of your machine whose [connection]
is [USB] is already displayed, select it and click
[Delete], and then click [Add].

11 Select the name of your machine whose

[Connection] is [USB], and then check
that [OKI MC562(PS)] is displayed in
[Print Using].

12 Click [Add].
13 Check that the name of your machine

is displayed in [Printer List], and then
close the window.

Follow the instructions displayed on the screen to
complete the installation.

9

From the [Go] menu, select [Utilities],
and then double-click [Printer Setup
Utility].
Note

●● If [Printer Setup Utility] is already running, close
once and reopen.

14 Remove “Software DVD-ROM” from the
computer.

The installation is complete.
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◆◆Print a test page to check that the printer
driver is successfully installed on the
computer.

Starting a Print Job
This section explains how to configure the print
settings such as paper size, paper source, and
media weight, and start printing on each printer
driver you are using.

1

From the [Go] menu, select
[Applications] > [TextEdit].

2

Select the [File] menu > [Page setup].

3

Select the name of your machine from
[Format for].

4

Click [OK].

6

Select the [File] menu > [Print].

7

Select the name of your machine from
[Printer].

●● This section uses NotePad in Windows and TextEdit in Mac
OS X as examples. The display and procedure may differ
according to the operating system, the applications, and
the version of the printer driver you are using.
●● For additional information on the setting items on the
printer driver, refer to the driver’s help.

For Windows PCL/PCL XPS Printer
Driver
1

Open the file you want to print from an
application.

2

From the [File] menu of the application,
select [Print].

3

Select the PCL or PCL XPS driver.

4

Click [Preferences].

5

On the [Setup] tab, select a paper size
from [Size].

Click [Print].
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8

Memo

Check that [OKI MC562(PS)] is
displayed correctly under [Format for].

5

You need to install a printer driver on the computer
before starting a print job. (except AirPrint)

Printing from a Computer

6

6

Select a tray from [Source].

Select a tray from [Paper Source].

Memo

●● If you select [Auto] for a paper source, the tray with
the designated paper type is automatically selected.

7

Select a media weight from [Weight].
Memo

●● For general use, [Printer Setting] suffices for
paper weight. When you select [Printer Setting],
the paper weight setting configured on the operator
panel menu of the machine is applied.

8

Click [OK].

9

Click [Print].

For Windows PS Printer Driver

5
Printing

1

Open the file you want to print from an
application.

2

From the [File] menu, select [Print] to
open the print dialog box.

3

Select the PS driver.

4

Click [Preferences].

5

Select the [Paper/Quality] tab.

Memo

●● If you select [Automatically Select] for a paper
source, the tray with the designated paper type is
automatically selected.

7

Click [Advanced].

8

Click [Paper Size] and select a paper
size from the drop-down list.

9

Click [Media Type] and select the
media type from the drop-down list.
Memo

●● For general use, [Printer Setting] suffices for
paper weight. When you select [Printer Setting],
the paper weight setting configured on the operator
panel menu of the machine is applied.

10 Click [OK].
11 Click [OK].
12 Click [Print].
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9

For Mac OS X PS Printer Driver
1

Open the file you want to print from an
application.

2

From the [File] menu, select [Page
Setup].

3

Select the PS driver from [Format For].

Select [Paper input options] from
[Feature Sets].

10 Select a media type from [Media Type].
Select a paper size from [Paper Size]
and then click [OK].

5

From the [File] menu, select [Print].

6

Select [Paper Feed] from the panel
menu.

Memo

●● For general use, [Use Printer Settings] suffices
for paper weight. When you select [Use Printer
Settings], the paper weight setting configured on
the operator panel menu of the machine is applied.

11 Click [Print].
For Mac OS X AirPrint
1

Open the file you want to print from an
application.

2

From the [File] menu, select [Print].

3

Select the [OKI-MC562] from [Printer].

4

Set [Copies] input copy number.

Memo

●● If the print dialog box contains only two menus and
does not contain the options you expect to see,
click the [Show Details] button for Mac OS X 10.7
and 10.8, or click the disclosure triangle beside the
[Printer] menu for Mac OS X 10.5 and 10.6.

7

Select a tray on the [Paper Feed]
panel.
Memo

●● If you select [Auto Select] for a paper source, the
tray with the designated paper type is automatically
selected.

8

Select [Printer Features] from the
panel menu.
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5

Select [Media & Quality] from the
panel.

6

Set [Copies] input copy number.

6

Select a tray on the [Feed from] panel.

7

Tap [Print].

7

Click [Print].

For iOS AirPrint

5
Printing

1

Open the file you want to print from an
application.

2

Select

3

Select [Print] icon.

4

[Printer Options] is displayed.

5

Select Printer.

in the upper right corner.
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